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About Crossword Construction Kit 

Crossword Construction Kit is a must have tool for educators, students, publishers, corporate trainers and puzzle 

enthusiasts to quickly produce professional looking puzzles. Design your own puzzle page layout -- drop, place and 

size the puzzle, graphics and text components. Select fonts, colors, columns, borders, alignment and more.

Quickly Create Puzzles

Crossword Construction Kit is a great way to create theme based crossword puzzles of various shapes 

and sizes. You can literally create great looking crosswords in minutes using the default settings. Just 

enter your words and clues, select a shape and layout and then save.

Puzzle Shapes

The program features the unique ability to make puzzles in fun shapes with over 100 predefined puzzle 

shapes (diamonds, doughnuts, trains, etc). Use the shape creator to build an unlimited number of new 

shapes. Create puzzles up to 49 x 49 in size with a maximum of 200 words per puzzle and up to 150 

characters per clue.

              

Puzzle Layouts

Design your own puzzle page layout -- drop, place and size the puzzle, graphics and text components. 

Select fonts, colors, columns, borders, alignment and more. Insert images as backdrops to reinforce 

puzzle concepts. Or choose from any number of predefined layouts supplied with the program.

Print Output Options

Print options include skeleton or filled box, font selection, answer key, partial answer key or selected 

letters as hints. Output puzzles to paper, clipboard, bitmap, JPEG, metafile, HTML ready web page or as 

a playable puzzle.

Interactive Puzzles

The program also includes a Puzzle Player unit. Export the puzzles in a java format and solve the puzzles 

interactively on screen. Or place interactive puzzles on the Internet to enhance a web site.

 

Why use Crossword Construction Kit?

Below are a just few ideas for using Crossword Construction Kit. 

  

Teachers

Create puzzles for vocabulary, spelling, reading reviews, foreign language studies and more. Create puzzles as 

chapter reviews, quizzes or extra credit. Include a bonus question on the puzzle. Create or use puzzle shapes that 

match your subject material or lay the puzzle over top of a supporting graphic image.

 

Students

Quickly create puzzles required as homework or extra credit. Dazzle your teacher and fellow students with the 

quality of puzzles produced.

 

Publishers

Create professional looking puzzles with an assortment of colors, shapes and graphics. Export the puzzle to a 
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Create professional looking puzzles with an assortment of colors, shapes and graphics. Export the puzzle to a 

Windows metafile, bitmap, JPEG or PNG image and load it into your own software package.

 

Corporate Trainers 

Liven up course material with creative crossword puzzles. It's a great tool to help trainees, new hires and others 

reinforce their understanding of key concepts.

 

Puzzle Enthusiasts 

Build fun puzzles for friends, family and others. Create a puzzle with a picture of yourself or family with the puzzle 

overlaid on the picture! Easily post your puzzles onto a Web page.

 

Other Uses

Generate puzzles for Newsletters, Church Bulletins, Scouts, Wedding Showers, Contests, Parties and more.
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What's New in Crossword Construction Kit 5

The next generation of Crossword Construction Kit
Crossword Construction Kit 5 has a new modernized look that also enhances program functionality. This list 

highlights some of the most important changes.

1. Improved the play options for solving a puzzle on your computer.

Select the puzzle and click the Play button to start solving a puzzle. The puzzle appears as designed in the 

Page Layout.

2. Major enhancements to generate Playable or Printable HTML pages.

• Enhanced and simplified export of puzzles for use on web pages. Now upload the puzzles to a 

website just as they look in the Puzzle Preview window or on paper.

• Use templates to change the look and feel of web page puzzles.

• The 'Create Printable/Playable Puzzle Page' templates use more modern web page standards such 

as styles and classes.

• Added an editor dialog to allow the user to edit Playable or Printable template files.

• Improved the Save Web (Create Web Page) dialog.

3. Extensive hints, helps, shortcuts and samples allow you to create crossword puzzles faster and 

easier than ever before. 
• Press F1 to bring up context sensitive help throughout the program. 

• Added shortcuts such as ctrl-s to save and ctrl-p to print. 

• Hover the mouse pointer over input fields to view more information about what to enter or how to 

choose. 

• Preview the layout and shape while creating the puzzle. 

• Updated help file. 

• Updated Quick Start Guide. 

• New sample puzzles, shapes and layouts included.

4. Added new sound options for the interactive puzzles.

• Added sounds for Check Puzzle - Error Found and Check Puzzle - All are Correct.

• Choose from a variety of sounds to use for the Winner, Did Not Win, Right Answer and Wrong 

Answer options.

5. Updated program to work seamlessly with the latest operating systems.

Runs on Windows 7 and 8.

6. Improved the functionality of the thesaurus.

Use the thesaurus to automatically replace an existing word or clue.

7. The .png image file format is now supported.

Save puzzle images in a .png format or use .png images as puzzle backdrops in the page layouts.

8. Available in a portable version.

Take Crossword Construction Kit with you. Run the program from a USB drive or other portable drive. Just 

attach to any Windows computer and start using the program.

9. Display Scaling

Now supports display scaling on Vista and later.
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Upgrading from Version 4.x

By default, Crossword Construction Kit 5 is installed in the same folder as Crossword Construction Kit v4.x. 

  

Crossword Construction Kit 5 will read puzzles created by Crossword Construction Kit v4.x - .cw3 files. There are two 

primary methods for loading the puzzles from a previous version.

1) Export your puzzles (File > Export Puzzles) from v4.x and save to a new file.  In Crossword Construction Kit 5 

click on File | Import Puzzles to load them into the your current puzzle file. 

2) Click on File | Open Puzzle Collection File, navigate to the .cw3 puzzle file and load it in.

 

 The puzzles are interchangeable between the two versions.
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Installing Crossword Construction Kit

  

The steps for installing Crossword Construction Kit are fairly standard. 

  

1. First download the program from www.crosswordkit.com. 

2. Save the downloaded file to a folder on your hard drive. 

  

3. Locate the downloaded file and double click the .exe file to start the installation process. 

  

4. Follow the on screen instructions to complete the install.

To get started with the program, read the Introduction and the Tutorial sections of the Crossword Construction Kit 

Help. 

  

Licensing Crossword Construction Kit 

If you have purchased the license for Crossword Construction Kit you will receive a license code. From the 

Crossword Construction Kit window click on Help | License Crossword Construction Kit to activate the License 

Information window. Enter your name and code exactly as they appear on the license instructions you received 

when you purchased Crossword Construction Kit. Press OK to save the license information. Your license status will 

now display in the lower left corner of the Crossword Construction Kit window. 

  

See the Advanced License Information topic for consideration of Administrator and non-Administrator login rights 

and Crossword Construction Kit licensing. 
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Advanced License Information 

Windows can be configured to allow different users to log into a single computer. Windows XP and later require 

users to log in. Normally only one user is logged in at a time. One or more login names have access to the entire 

computer and are said to have administrative access rights. Other login names do not have administrative access 

rights. These login names have restrictions about what they can change on the computer. 

   

If the Name and Code are entered into the License Information dialog when you are logged in as an administrator, 

Crossword Construction Kit will be licensed for all users. If, however, the License Information is entered when you 

are logged in as a non-administrator, Crossword Construction Kit will only be licensed for that user login. 

   

8



Uninstalling Crossword Construction Kit 

To remove Crossword Construction Kit from your computer follow the steps below: 

1) Click on File | Exit Program to close Crossword Construction Kit.  

2) From the taskbar, click the Start menu button to open the Start menu. 

3) Open the Windows Control Panel. 

4) Based on the version of Windows you are running, select the option from the control panel used to uninstall 

applications. 

5) Highlight Crossword Construction Kit in the list of installed programs.

6) Again, depending on your version of Windows click on the option to remove the program. 

7) Follow the on-screen prompts to remove Crossword Construction Kit from your computer. 

  
**There i s  no uninsta l ler in the portable vers ion. Use Windows Explorer to delete the fi les .
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Tutorials Introduction

These tutorials step you through the basics of using Crossword Construction Kit. Several video tutorials are also 

available online at www.crosswordkit.com/videotutorials.htm.

                 

      

� The Creating a Puzzle tutorial walks you through the basic steps of creating a puzzle and shows you the 

options available for puzzle output.

� The Creating a New Shape tutorial demonstrates how to design a new puzzle shape for use with crosswords 

that you develop.

� The Creating a Page Layout tutorial shows how to build a new page layout. See how to drop, place and size 

the puzzle, graphics and text components to make your own layout for print or export.

� The Create a web page with a playable puzzle tutorial outlines the steps for posting a playable puzzle to a 

website.

� The Create a web page with a printable puzzle tutorial steps you through the process of posting a puzzle 

online that visitors may print and solve on paper.

� The Using HTML Templates tutorial details how to create a puzzle web page that matches your website.
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Tutorial - Creating a Puzzle 

This guide is designed to help you understand the basics of the program. We will step through the creation of a 

simple crossword puzzle, choose a layout and prepare for printing. 

  

Creating a Puzzle 
To create a puzzle, first open the Crossword Construction Kit program. Click on the New Puzzle button to open the 

Create New Puzzle window. 

  

The cursor automatically defaults to the title field in the Create New Puzzle window. Enter "Western State Capitals" 

(without the quotation marks) in the title field. After entering the title name, press the TAB key to move to the 

category field. Use the drop down list box to choose one of the three default categories already defined or type in 

the name of a new category. For this tutorial, enter "Geography" as the category. 

  

Next, click on "Click here to add a new row". Type Phoenix in the Word field. Press Enter to advance to the Clue 

field and type Arizona. Press Enter and Phoenix is placed as the first item in the word list and Arizona is placed in 

the Clue column. The cursor returns to the Word edit box to continue adding words. 

  

Enter the following western capitals and states into the puzzle using the steps listed above. 

 

Word Clue

Boise Idaho 

Carson City Nevada

Cheyenne Wyoming

Denver Colorado 
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Helena Montana 

Honolulu Hawaii

Juneau Alaska

Olympia Washington

Sacramento California

Salem Oregon

Salt Lake City Utah

Santa Fe New Mexico

  

After entering the words, click on the Spell Check button to check the list for possible spelling errors. Any words 

that cannot be found in the dictionary are highlighted and a list of possible corrections are displayed. You can opt to 

ignore, replace or add the word to the dictionary. 

  

Puzzle Shape 
Now that the puzzle words and clues are complete, it is time to choose a shape for the puzzle. Click on the Shape 

button to open the Shapes window.  Press the up or down arrow to view the different shapes available. The shapes 

are sorted by size. Highlight the 21 x 21 Diamond shape and click on the Select button.

  

You can also create your own shapes. This is discussed in the Creating a New Shape tutorial. 

  

Page Layout 
The next step is to select the page layout of the puzzle. The page layout defines the position of the puzzle body, 

words, title, etc. Click on  the Layouts button to open the Puzzle Page Layouts window as shown below. The program 

has several predefined layouts to choose from. Highlight a description to display the layout design.  A color key at 

the bottom of the image lists which parts of the puzzle each color represents. 
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Of course, if you do not like any of the layouts provided, you can make your own. Just click on the New button and 

start designing. The Creating a New Layout tutorial walks you through this process. 

  

For this tutorial, highlight the Big Puzz, Small Clue layout and click on the Select button. This returns you to the 

Create New Puzzle window.  The puzzle layout we selected is now displayed in the Puzzle Appearance screen.   

Puzzle Creation 
The next step is to see if all the words will fit into the puzzle shape selected. For this tutorial, leave the Shrink and 

Letter Count options unchecked. 

 

Now click on the Create button. A dialog box quickly displays how many attempts have been made so far to 

generate the puzzle. 

  

A  Created Puzzle window opens displaying the four best puzzle  fits. To the right will be a list of the words that fit 

into the puzzle and a list of those that did not. Click on the puzzle fit you prefer and click on the Save Puzzle button. 

You can zoom in on a puzzle fit by double clicking on it with the mouse. If you do not like any of the fits, click on the 

cancel button. You can then try again or change the puzzle shape to one that better fits the list of words. 
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For this tutorial, click on the Best Fit puzzle - the one in the upper left hand corner. Then click on the Save Puzzle 

button. After saving the puzzle, the puzzle is highlighted in the Crossword Construction Kit window. 

  

Print Puzzle 
With the puzzle you just created still highlighted, click on the Print Puzzle button. The Print window opens with a 

set of options to choose from. 

 

You can select the parts of the puzzle you want to print, such as Title, Body, Clues, Words and Bonus Question. The 

Puzzle Overrides section lets you make other adjustments to the puzzle before printing. The Answer Key option 

allows you to print the entire answer key or print partial answers. 

  

Select the options as shown in the image above. After making the selections click on the View/Print button. A 

14



Select the options as shown in the image above. After making the selections click on the View/Print button. A 

dialog box appears stating the puzzle has been generated. Click OK and the puzzle layout and all options chosen will 

be displayed on the screen for preview before printing (as shown below). 

  

If everything looks ok, click on Print Puzzle to open the Printer dialog to select number of copies, printer, etc. 

  

If adjustments need to be made before printing, click on the X in the upper right hand corner to return to the 

Reports window to make changes. 

  

Exporting Puzzles As Graphics 
At this point, you can also choose to save the puzzle as a graphic image which can be used in desktop publishers or 

word processors. Click on Save Image and select one of the image file types available. Save the image to a specific 

file name and location.   

Summary 
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Summary 
You have now completed the basic functions for creating your own crossword puzzle. We have created a quick, bare 

bones puzzle. You may want to take time to learn about some of the other features of the program such as adding 

graphics to the layouts, importing and exporting, and posting to web sites. 
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Tutorial - Creating a New Shape 

In this tutorial we will design a simple puzzle shape that can be used with puzzles that you create. We'll create a 15 x 

15 octagon shaped puzzle. 

  

From the Crossword Construction Kit window click on Edit | Puzzle Shape to open the Shapes window as shown 

below. 

Click on the New button to open the Shape Creator window. The cursor should already be in the Title edit box. Enter 

the name Octagon in the Title field. Tab to the Width field and enter 15. Tab to the Height field and enter 15. Press 

Tab again and the image will be resized to a 15 by 15 square. 
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Next, from the right hand corner of the image, count down five spaces. Click on this square to turn it white. Then 

move up diagonally to the left and click on the four remaining squares to create a diagonal line as shown in the 

image above. 
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Do the same thing in the other three corners so that the image looks like the above. 
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Now, right mouse click in each of the four corners to fill the corners with white squares as shown above. 

  

The octagon is now complete. When used with a puzzle, the program will attempt to fit all words into the black area 

of the image. Click Save to save the new shape. It is now listed in the Shapes window and available for use when 

creating a puzzle. 
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Tutorial - Creating a Page Layout

In this tutorial we'll design a page layout that can later be used with puzzles that you create. We'll create a simple 

layout to demonstrate how this is done. It will provide a foundation for creating more sophisticated designs later.

 

Puzzle Page Layouts 

To begin, click on Edit | Page Layout from the Crossword Construction Kit window to open the Puzzle Page Layouts 

window. 

 

This window lists layouts already created. Click on the New button to open the Page Creator window where the 

actual page design occurs.

Page Creator 
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The first step is to assign a name to the layout. In the name field, enter Tutorial. Next make sure the paper size is set 

to Letter and the orientation is set to Portrait.

 

Title
Now we will start designing the layout. Click on the Title icon and move the mouse to the layout grid area. Click in 

the grid area to insert a gold Title rectangle. Right click on the Title rectangle to open a menu. Left click on the Size 

and Position menu option to open the Size & Location of Title window. 

 

Edit the values to resize and reposition the title. In the Left field, enter 3.250. This leaves a 3.25 inch margin on the 

left. Enter .9 in the Top field to leave a margin of .9 inches at the top. Enter a width of 2.000 and a height of .250 to 

make the title box two inches wide and a quarter inch high. Click OK to save the changes and move the Title 
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make the title box two inches wide and a quarter inch high. Click OK to save the changes and move the Title 

rectangle to the coordinates entered. 

 

Puzzle
Click on the Puzzle icon and then click somewhere below the Title rectangle on the layout grid. A red colored puzzle 

block is displayed in the layout. Right click on the puzzle box to open the menu. Left click on Size and Position to 

open the Size & Location of Puzzle window.

 

 

Now edit the values in this window. In this example we'll make a large puzzle area. In the Left field, enter 1.0 to 

leave a one inch margin on the left. Enter 1.5 in the Top field to so that the top edge of the puzzle is 1.5 inches 

below the top of the page. Enter a width of 6.5 and a height of 6.5 to make the puzzle box 6.5 inches square. Click OK 

to resize and move to the coordinates and save the changes.

 

Across Clues
Click on the Across Clues icon and then click somewhere below the puzzle box on the layout grid. A blue colored 

Across Clues block displays in the layout. Right click on the Across Clues box in the layout to open the menu. Left 

click on Size and Position to open the Size & Location of Across Clues window.

 

 

Now edit the values in this window to size and position the header box. In the Left field, enter 1.0 to leave a 1.0 inch 

margin on the left. Enter 8.5 in the Top field so that the top of the header box is 8.5 inches below the top of the 

page. Enter a width of 3.0 and a height of 2.0 to make the puzzle box 3 inches wide and 2 inches high.

 

Click OK to save the changes. The Across Clues box is resized and moved to the coordinates entered.

 

Down Clues
Click on the Down Clues icon and then click somewhere below the puzzle box on the layout grid to display a green 

Down Clues block in the layout. Right click on the Down Clues box to open the menu. Left click on Size and Position 

to open the Size & Location of Down Clues window.

 

 

Now edit the values in this window to size and position the box. In the Left field, enter 4.5 to leave the left edge of 

the box 4.5 inches from the left edge of the page. Enter 8.5 in the Top field so that the top of the header box is 8.5 

inches below the top of the page. Enter a width of 3.0 and a height of 2.0 to make the puzzle box 3 inches wide and 2 

inches high.

 

Click OK to resize the Down Clues and move to the coordinates entered, just to the right of the Across Clues.

  

Across Clue Header and Down Clue Header 
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Across Clue Header and Down Clue Header 
Lastly, we'll add the headers above the Clue boxes so that the printed puzzle will show which clues are the Across 

clues and which are the Down clues. Click on the Across Header icon and click below the Puzzle box and above the 

Across Clues box to insert a small blue Across Header box. Click on the Across Header box once to place small square 

boxes around the corners and mid-points of this box. Hold down the left mouse button and drag the box so that it is 

centered above the Across Clues box. 

  

Click on the Down Header icon and click below the Puzzle box and the above the Down Clues box to insert a small 

green Down Header box. Then follow the steps above to drag the box and center it above the Down Clues box. 

The page should look as shown below.

    

Click on the Save button to save the new format created. It can now be selected as a layout when creating or 

modifying puzzles.

  

Note: Any of the boxes may be dragged and resized with the mouse. Or you can use the Size and Location windows 

to create exact sizes and positioning. A right mouse click on any of the boxes will open a menu where you can select 

other options that we did not use in the tutorial. You can change font types, size or color, number of columns in the 

clues, etc.   
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Tutorial - Create a web page with a playable puzzle

Use Crossword Construction Kit to create a web page containing a puzzle that can be solved by visitors to your 

website. Visitors to your website must have Java installed in order to solve the puzzle online. A puzzle on your website designed for printing does not 

require Java.

In this example we will show how to create a playable puzzle that can be uploaded to your web server and made 

available to be solved by visitors to your website.

We will use the Authors and Classics puzzle available in the sample puzzles included with the program. Highlight 

the puzzle and click on the Print Puzzle button to open the Print puzzle window.

For this example we will use the default values. Click on the OK button to open the Puzzle Preview window.
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The image above displays what the puzzle will look like on the web page. Next click on the Save Web button and 

choose the Playable button from the Create Playable Puzzle Page window that opens.
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The Create Playable Puzzle Page as shown in the image above allows you to choose what to place on the web page. 

In the top two fields we have entered the web page title and the puzzle author. We included a header providing 

some instructions for solving the puzzle. 

We have selected which puzzle options to display and which sound effects to use. We also selected a puzzle width. 

With the settings defined, click on the Create Page button. You will be prompted to save the .htm page to your hard 

drive. Select the location (preferably an empty folder) and click on the Save button.

Once the web files have been created you may see the puzzle as it will look when uploaded to your web server by 

clicking on the View Page button. Your default browser will be loaded and the web page displayed. Depending on 

your browser or your security settings you may need to click various dialogs to tell the browser to allow the page to 

be displayed.
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After clicking the Save button several files are saved in the folder you selected. Upload all of these files to your web 

server. All of the files need to be uploaded to the same folder on your web server. To avoid conflicts with other 

puzzles we recommend they be uploaded to a unique directory on your server.

Once the files are uploaded to your server the puzzle should ready for use by typing the correct web address. 

Contact your server administrator if you need help with the correct web address or to adjust file permissions on 

your server.

Additional Information

Enhance the look of your puzzles by adding other text in the headers or footers. You may choose fonts, sizes and 

colors used in the headers or footers. Only one font, size and color may be selected for each header or footer.

A basic HTML template is provided that will create a web page with the puzzle on a white background. You can edit 

the HTML template to create puzzles that match the look of your web site along with your puzzle. See the Using 

Templates tutorial for more information.

See the Create a web page with a printable puzzle tutorial to create a web page containing a puzzle that users can 

print and solve on paper.
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Tutorial - Create a web page with a printable puzzle

Use Crossword Construction Kit to create a web page containing a puzzle that can be printed by visitors to your 

website.

In this example we will show how to create a printable puzzle that can be uploaded to your web server and made 

available to be printed by visitors to your website.

We will use the Authors and Classics puzzle available in the sample puzzles included with the program. Highlight 

the puzzle and click on the Print Puzzle button to open the Print puzzle window.

For this example we will use the default values. Click on the OK button to open the Puzzle Preview window.
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The image above displays what the puzzle will look like for print. Next click on the Save Web button and choose the 

Printable button from the  Create Puzzle Page window that opens.
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The Create Printable Puzzle Page as shown in the image above allows you to choose what to place on the web page. 

In the top two fields we have entered the web page title and the puzzle author. We included a header providing 

some instructions for solving the puzzle. 

We have selected which puzzle options to display and which sound effects to use. We also selected a puzzle width.

With the settings defined, click on the Create Page button. You will be prompted to save the .htm page to your hard 

drive. Select the location (preferably an empty folder) and click on the Save button.

Once the web files have been created you may see the puzzle as it will look when uploaded to your web server by 

clicking on the View Page button. Your default browser will be loaded and the web page displayed. 
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After clicking the Save button both of the files shown in the image above are placed in the folder you selected. All 

of the files need to be uploaded to the web server and saved to the same folder. Note: If you do not include an 

image in the puzzle layout, then only the .htm file will be created. It will be the only file that you need to upload.

Once the files are uploaded to your server the puzzle should be ready for use by typing the correct web address. 

Contact your server administrator if you need help with the correct web address or to adjust file permissions on 

your server.

Additional Information

Enhance the look of your puzzles by adding other text in the headers or footers. You may choose fonts, sizes and 

colors used in the headers or footers. Only one font, size and color may be selected for each header or footer.

A basic HTML template is provided that will create a web page with the puzzle on a white background. You can edit 

the HTML template create puzzles that match the look of your web site along with your puzzle. See the Using HTML 

Templates tutorial for more information.

See the Create a web page with a playable puzzle tutorial to create a web page containing a puzzle that users can 

solve online.
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Tutorial - Using HTML Templates

Crossword Construction Kit allows you to create pages that can be uploaded to your web server for visitors to print 

or solve puzzles. Templates control the design of the resulting web pages. By editing the templates you can create 

pages that match the design of your website. Basic sample templates are included that create pages with a plain 

white background.

A template file is provided to create web pages that contain printable puzzles and another to create web pages that 

contain playable puzzles. Templates can be edited using the built-in editor. Load the editor by following these 

steps:

1) Click Print Puzzle and OK to bring up the Puzzle Preview dialog.

2) Click the Save Web button to bring up the Create Puzzle Page dialog.

3) Click either the Playable or Printable button, depending on which template you want to edit.

4) Click the Template button to load the template editor.

Various tags in the templates indicate where certain puzzle elements will be placed. For example: 

• <!---#TITLE#---> displays the title of the puzzle.

• <!---#FIRSTHEADER#---> indicates where the first puzzle header should be placed.

• <!---#SECONDFOOTER#---> is where the second footer is located.

A sample playable HTML template file is also copied to the Puzzle data folder in the file 

PlayableHTML_CWK_Template.htm. Look at this file in an editor to get an idea how to create your own customized 

templates.

Notes

The default playable HTML template file is PlayableHTML_Template.htm. The default printable HTML template file 

is PrintableHTML_Template.htm. Both of these files are located in the Puzzle data folder. They contain basic 

templates to create web pages that display puzzles with a plain white background.

Multiple template files can be used by selecting different file names in the preferences found in Options, 

Preferences, File System, and "Playable Puzzle HTML Template file" or "Printable Puzzle HTML Template file".
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Editing templates requires HTML coding knowledge.

Other Resources
• See the Create a web page with a playable puzzle tutorial to create a web page containing a puzzle that 

users can solve online.

• See the Create a web page with a printable puzzle tutorial to create a web page containing a puzzle that 

users can print and solve on paper.
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Crossword Construction Kit Window 

The Crossword Construction Kit window consists of the menu commands and a list of puzzles created. Categories 

may be defined and puzzles are stored in those categories.  Highlight a puzzle category to display all puzzles saved 

to that category.

  

Menu

The menu items provide access to all areas of the program, from editing to setup and more. The icons provide quick 

access to program functionality.

New Puzzle
Click on this icon to open the Create New Puzzle window and start working on a new puzzle.

Play Puzzle
Highlight a puzzle found in the Puzzles column and click on the Play Puzzle icon to load a java version that allows 

you to solve the puzzle on screen.

Print Puzzle
Highlight the puzzle to print and click on the Print Puzzle icon to start the print process.

Delete Puzzle
Select the puzzle or puzzles from the list and click the Delete Puzzle icon to remove them from the list and file.

 

Note: To make changes to an existing puzzle, double click on the puzzle name in the Puzzles column. This displays 

the Modify Existing Puzzle window where changes may be made and saved.

Categories

Puzzles are assigned to categories to help more readily find a puzzle already created and saved. The category is 

assigned to the puzzle at the time the puzzle is created or modified. Categories may be set up by subjects, interests, 
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assigned to the puzzle at the time the puzzle is created or modified. Categories may be set up by subjects, interests, 

dates, uses or any other method that will help you quickly find a puzzle. Click on a category to see all of the puzzles 

assigned to that category. 

  

Puzzles 

In the example above there are twelve puzzles saved to the Puzzles Volume 1 category. Double click on one of the 

puzzles to edit that puzzle. Or highlight the puzzle and click on the Play, Print or Delete button to perform the action 

required. 

Status Bar

The status bar at the bottom of the windows displays three items.

• The program license status.

• The number of puzzles contained in the open category.

• The name and location of the puzzle (.cw3) file in use.
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Puzzle Collections 

Crossword Construction Kit is capable of handling virtually an unlimited number of puzzles in an unlimited number 

of puzzle collections. A puzzle collection is a set of puzzles saved in one file on the computer. Puzzles may be saved 

in groups based on educational subject, family puzzles, church puzzles or any other grouping desired. The puzzle 

collection name is that of the file name. The file name uses a file extension of .CW3. 

  

You can create new puzzle collections by clicking on File | New Puzzle Collection File. A standard Windows box 

appears requesting file name and in which folder to save the file. 

  

You can easily access an existing puzzle group by clicking on File | Open Puzzle Collection File and following the 

path to the file.

  

If you later decide that a puzzle you created and saved belongs in a different file group, the puzzle can be imported 

into the correct group. While in the file group you want the puzzle to be in, click on File | Import and follow the 

standard Windows dialogs. 

  

Export puzzles to a new puzzle collection by clicking on File | Export | Export Puzzles and following the standard 

Windows dialogs. 
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Modify a Puzzle 

It is easy to modify puzzles already created. From the list of puzzles in the Crossword Construction Kit window, 

double click on the one to be modified. The Modify Existing Puzzle window opens - similar to the Create New 

Puzzle window - where you can make any changes needed. 

If adding or removing words and clues from the previously saved puzzle, you will need to click on the Create button 

to generate the puzzle again and save. 

  

Crossw ord Construction Kit w indow  > Puzzle > Modify Puzzle or double click on puzzle
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File 

New Puzzle Collection File 

A puzzle collection is a collection of puzzles saved in one file.  You can organize your puzzles and save them into a 

group if so desired. Clicking on File | New Puzzle Collection File will allow you to create a new puzzle collection or 

.cw3 file. The window, Create New File Group, appears asking you to name the file and select the location of the 

file. 

  

Open Puzzle Collection File 

This option allows you to select which puzzle collection to open. The Open Puzzle Collection window opens so that 

you can select the file and the folder where the file is located. 

 

Reopen 

This is a convenient way to open a previously used puzzle file. This option displays the last five puzzle files that 

were opened. Click on the file you want to load it into Crossword Construction Kit. 

 

Import  

Use this function to import puzzles located on another drive, folder, file, etc. All puzzle files have a file extension of 

.cw3. 

  

Export Puzzles 

Export puzzles from the existing file to another location on the computer or network. 

Print Puzzle 

First highlight a puzzle to print and click on File | Print Puzzle. Or click on the Print Puzzle button. These methods 

open the Reports window where you can select the print options. 

  

Printer Setup 

This option opens a standard Print Setup window for selecting the printer, paper size, paper orientation and print 

properties. 

  

Exit 

Exit closes the program. 

Crossw ord Construction Kit w indow  > File menu
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Export Puzzles 

Puzzles may be imported and exported. This feature facilitates the exchange of puzzles as well as providing a 

means to archive puzzles. A special file structure (*.CW3) is used for importing and exporting. You can swap puzzles 

with friends and associates who also use the Crossword Construction Kit. 

  

To export a file click on File | Export Puzzles from the Crossword Construction Kit window. The Export Crossword 

Puzzles window appears, listing all puzzles available for export. You may select one or more puzzles to export by 

clicking on and highlighting each puzzle required. 

Crossw ord Construction Kit w indow  > File > Export Puzzle

  

Select All

Click on this button to highlight all puzzles for export.

Clear All

This option removes the highlighting from any puzzles selected. At this point, no puzzles are selected for export.

Save File

After selecting the puzzle(s) to export, click on the Save File button. A standard windows dialog appears requesting 

that you name the file and select a destination folder to save the new .cw3 file. 

Click Exit to cancel the export process and return to the previous window.

40



Import Puzzles 

Puzzles may be imported and exported. This feature facilitates the exchange of puzzles as well as providing a means 

to retrieve archived puzzles. A special file structure (*.CW3) is used for importing and exporting. You can swap 

puzzles with friends and associates who also use the Crossword Construction Kit. 

To import puzzles from a file click on File | Import from the Crossword Construction Kit window. A standard 

Windows dialog prompts you to select the file from which you will be importing the puzzles. Selecting the (*.cw3) 

puzzle file opens the Import Crossword Puzzles window as shown below, listing all puzzles available for import. 

 

Crossw ord Construction Kit w indow  > File > Import 

Select All

Click on this button to highlight all puzzles for import. Or if only needing to import one or several of the listed 

puzzles, just click and highlight the ones wanted.

Clear All

This option removes the highlighting from any puzzles selected. At this point, no puzzles are selected for import.

OK

After selecting the puzzle(s) to import, click OK. The selected puzzles are imported to Crossword Construction Kit 

and may be found in the category it was assigned. 

Click Cancel to stop the import process and return to the previous window.
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Edit 

The edit menu found in the Crossword Construction Kit window provides the following three options.

Page Layout 

Select this option to open the Puzzle Page Layouts window. This window allows you to select a layout for additional 

editing or to create a new layout design.

  

Puzzle Shape 

Open the Shapes window to create new puzzle shapes or modify existing ones. You can also import and export 

shapes. 

  

Puzzle Words 

Use this option to open the Manual Word Addition window to manually add words to the puzzle highlighted. 
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Puzzle Menu

The puzzle menu found on the Crossword Construction Kit window provides the following five options:

New Puzzle 

Select this option to open the Create New Puzzle window to start creating a new puzzle. Or click on the New Puzzle 

icon to achieve the same thing.

  

Modify Puzzle 

First highlight a puzzle that needs to be modified. Then click on Puzzle | Modify Puzzle to open the Modify Existing 

Puzzle window. This window allow you to make modifications to the puzzle selected. Or double click on the puzzle 

to begin modifications.

 

Copy Puzzle 

Make a copy of the puzzle that is currently highlighted. Highlight the puzzle and click on Puzzle | Copy Puzzle. It 

makes a duplicate copy of the highlighted puzzle and opens the Create New Puzzle (copy of existing puzzle) 

window where you can make any changes to the copy. 

  

The copied puzzle will be named the same as the original except the name will be followed with a number in 

parentheses, such as Title (1). After making changes to the copied puzzle, rename it to distinguish it from the 

original. 

 

Delete Puzzle 

To remove a puzzle from the puzzle file, first highlight the puzzle to be deleted. Then click on File | Delete Puzzle or 

the Delete icon. A dialog box opens to verify that you want to delete the puzzle. Click Yes to delete the puzzle or No 

to cancel. 

Play Puzzle 

Highlight a puzzle and click on Puzzle | Play Puzzle or the Play Puzzle icon. This loads the puzzle in a java format to 

allow you to solve the puzzle on screen.   

Send Puzzle to

Use this menu item to start the process of outputting the puzzle to paper, an image file or to the web.

  
Crossw ord Construction Kit w indow  > Puzzle menu

43



Add to Dictionary 

Optionally add words to the dictionary, to be accepted as valid words in the spell checker. For example, you may 

plan on using proper names, locations, etc. in the puzzles, which may not be included in the dictionary. Adding 

these words to the dictionary will prevent the spell checker from stopping each time one of these words is found 

and requesting that you verify the spelling.

Selecting this option presents a window that lists all words previously entered as valid. Add or remove words from 

this list as needed.  

Crossw ord Construction Kit w indow  > Options > Add to Dictionary
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Exclude from Dictionary 

Optionally exclude words from the dictionary. From the Crossword Construction Kit window, click on Options | 

Exclude from Dictionary to access this feature. When spell checking the puzzle words or clues, the spell checker 

considers any words in the excluded list as misspelled and will prompt for verification. 

Selecting this option presents a window that lists all words previously entered as words. Add or remove words from 

this list as needed.  

Crossw ord Construction Kit w indow  > Options > Exclude from Dictionary
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Configure Bug Reporter 

The ISS Bug Reporter is called automatically when Crossword Construction Kit detects an error. It allows you to send 

us a report about the error. These reports help us identify and correct problems in Crossword Construction Kit. 

Information sent as part of a crash report is only used to fix the problem. The information will be kept confidential 

and will not be disclosed to anyone else. 

  

If an error occurs, you will need to configure the ISS Bug Reporter preferences before an error report can be sent. 

We recommend that you configure the preferences before unexpectedly needing to use the Bug Reporter. 

Crossw ord Construction Kit > Options > Configure Bug Reporter
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Appearance

Crossw ord Construction Kit w indow  > Options > Preferences > Appearance

Colors 

When creating page layouts in the Page Creator window, each component of the layout is designated by a colored 

box. This Preference panel allows you to customize the colors for each of the various layout components. Click on 

the Change button and select a new color.

Note: These colors do not affect printing of puzzles. The colored boxes help to better envision the layout 

composition. 

47



File System

Crossw ord Construction Kit w indow  > Options > Preferences > File System

File Paths

Crash report folder
Crossword Construction Kit includes a small Bug Reporter utility. In case of a program crash, this utility runs and lists 

any applicable crash data. This data may be emailed to us via the Bug Reporter utility. The data is also saved in a 

small .txt file. This option allows you to select where you would like to have this data saved on your computer.

If a firewall prevents you from emailing the report via the Bug Reporter utility, you can attach the .txt file to an 

email using your email client. Of course, you don't have to send us anything if you prefer not . We use the crash data 

reports to analyze the area of the source code where the error occurred and attempt to fix the problem. 

Puzzle data folder
This is the path where supporting program files such as page layouts, puzzle shapes, words added or excluded from 

the dictionary are stored. 

Playable Puzzle HTML Template File
A template is used to create a playable puzzle. Information about the puzzle, such as the title, headers, footers and 

the puzzle itself, are merged with the template file to create a web page. The template for the playable puzzle is 

stored in the location specified in the file path. Separate template files are used when creating Printable or 

Playable web pages. 

Printable Puzzle HTML Template File
A template is used to create either a playable or printable puzzle.  Information about the puzzle, such as the title, 

headers, footers and the puzzle itself, are merged with the template file to create a web page. Separate template 

files are used when creating Printable or Playable web pages. 
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Graphic Options 

Crossw ord Construction Kit w indow  > Options > Preferences > Graphics Options

  

Image Compression 

This option is used to control the file size of any puzzle image saved to a JPEG format. You can compress the file size 

from a range of 1 - 100. A setting of 100 creates the sharpest image, but also the largest file size. A setting of 1 (one) 

provides the smallest file size, but also the poorest image. In summary, the higher settings will produce sharper 

images with correspondingly larger file sizes. 

Use the slider bar to set the compression factor or insert a value from 1 - 100 in the edit box.
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Keyboard

Crossw ord Construction Kit w indow  > Options > Preferences > Keyboard

International Characters

Use the 12 hot keys provided to easily insert non-English language characters into puzzles. If these characters are 

not already assigned to your keyboard, this is a handy method for inserting them into the puzzle words and clues.

Click on the drop down list next to each key and select the character needed. Over 60 characters are available for 

use. The character selected is assigned to that hot key. When adding words and clues in the Create New Puzzle 

window, just press the assigned hot key to insert the character.
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Language

Crossw ord Construction Kit w indow  > Options > Preferences > Appearance

 

Dictionary Language

Crossword Construction Kit provides eight dictionaries that may be used for spell checking puzzle words and clues. 

Dictionaries Available
Dutch

English (U.S.)

English (U.K.)

French

German

Italian

Spanish

Swedish

Choose at Spell Check Time
If you plan to create puzzles in more than one language, use the Choose at Spell Check Time option. When the 

spell check process is started, you will be prompted to select a language.

Languages available
Dictionaries are available in English (U.S.), English (U.K.), Spanish, Italian, French, German, Dutch and Swedish. 

Select the dictionary that you want as the default. The spell check will occur in the language chosen.

Thesaurus

The Crossword Construction Kit supplies an English (U.S.) and an English (U.K.) thesaurus. These are available to 

help generate clues when creating the puzzle. 

Select the thesaurus option preferred. If using the Choose at Thesaurus Use Time option, you will be prompted to 

choose between the U.S. and U.K. versions when the thesaurus is activated. 
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Puzzle Options

Crossw ord Construction Kit w indow  > Options > Preferences > Puzzle Options

Clue Headers

Use this setting to display words other than Across and Down in the Puzzle Layout. If creating puzzles in a language 

other than English, insert the word equivalents in the appropriate fields. Note: This setting will only affect new 

puzzle layouts that are created. To change the headers of an existing layout, you will need to modify the layout.

  

The revised clue headers will also be displayed on a web site when exporting as an interactive puzzle. 

Word Separator Characters

This option allows you to place certain characters inside words that will display in the puzzle. Use this option for 

puzzle answers that may be hyphenated or contain multiple words. You may want to indicate the word separation in 

the puzzle itself. 

Choose from 4 characters (a dash, slash, plus or star) and a user defined character. To make use of this option, select 

the characters you want to use and then place them in the words when you create the puzzle.  

  

Note: The default character in the User Defined field is a space. Alpha-numeric characters are not supported in this 

field.

Other

The Puzzle Creation Attempts field allows you to enter a number from 1 - 999. The program will make "X" number of 

attempts to fit all words into the puzzle based on the number entered.
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Puzzle Player Options

Crossw ord Construction Kit w indow  > Options > Preferences > Puzzle Player

Highlight a puzzle and click on the Play Puzzle button to open the puzzle player component. Use these options to 

modify the puzzle player. Note: These settings also function as the defaults for the HTML/Player Export option.

Puzzle Player Options

Show the 'Check Puzzle' button

This button lets you know if the words entered into the puzzle have been entered correctly or not. A red X is 

displayed over top of any incorrect letters.

Show the 'I Give Up' button

Click on this button to display all of the answers to the puzzle.

  

Show the game timer 

A timer starts once the page is opened, displaying how long it takes to solve the puzzle. The timer stops when 

the puzzle is solved, showing the number of minutes and seconds required to solve the puzzle. Select this 

option to display the timer.

Sound Effects

Disable Sound Effects 

The program will play back a sound  when  the puzzle is complete. If the I Give Up button is pressed, then 

another sound plays. Sounds may also play when a right or wrong answer is entered into the puzzle and the user 

clicks on the Check Puzzle button. Checking this box disables the sound effects so that they will not play back in 

the Puzzle Player. 

Winner Sound 

When the puzzle has been solved the winner sound plays back if the sound effects option is turned on. 
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Did Not Win Sound 

If the puzzle was not solved completely and the I Give Up button is clicked, then the Did not Win .wav file 

plays, if the sound effect option is turned on.

Right Answer Sound

When the user clicks on the Check Puzzle button and there are no errors in the entries, the right answer 

sound file plays. 

Wrong Answer Sound

When a word is entered incorrectly and the user clicks on the Check Puzzle button, the selected wrong 

answer sound file plays.

Each of the four sound selections defaults to the Surprise me (let the computer choose) option. The program will 

randomly play back one of the sounds available when this option is selected. Other choices include no sound, the 

built-in sound or select a sound of your choice from the drop down menu.
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Startup

Crossw ord Construction Kit w indow  > Options > Preferences > Startup

Show Quick Start Guide 

This option displays the Quick Start Guide for Crossword Construction Kit each time the program loads. The guide 

contains basic program information. 
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Restore Program Defaults 

From the Crossword Construction Kit window click on Tools | Restore Program Defaults to restore any settings made 

in the program back to their default values. This will primarily affect any settings that you made in the Options | 

Preference area of the program. The default puzzle file that opens may also be affected. 

Crossw ord Construction Kit > Tools > Restore Program Defaults
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Export Program Configuration 

This option allows you to save all of the program configuration settings to a file. This would include any Preference 

settings selected, puzzle file in use, etc. From the Crossword Construction Kit window click on Tools | Export 

Program Configuration to export the settings. A Save File dialog prompts you to name the file and file location. If 

you need to retrieve this information later, you can use the Tools | Import Program Configuration to load the 

settings back in. 

   

You may want to save this information if you plan to move to another computer. You can then easily import your 

settings back into the program after you've installed on the other computer. Or if you have more than one user at a 

computer, each user could save their own configuration settings and load them in while they are at work on the 

computer.

Crossw ord Construction Kit > Tools > Export Program Configuration

**The export option i s  not ava i lable in the portable vers ion.
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Import Program Configuration 

This option allows you to import all previously saved program configuration settings into Crossword Construction 

Kit. This action replaces the current configuration settings in Crossword Construction Kit, which includes any 

Preference settings selected, puzzle file in use, etc. Click on Tools | Import Program Configuration to open a browse 

window where you can select the file to import.

Crossw ord Construction Kit > Tools > Import Program Configuration

**The import option i s  not avai lable in the portable vers ion.
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Create New Puzzle 

Puzzle development takes place in this window. Add words and clues, select a puzzle shape and layout, assign a 

puzzle title and category, and generate the puzzle from this window. 

Crossw ord Construction Kit > New  Puzzle button  

Create

Clicking on the Create button generates the puzzle and attempts to fit all of the words into the puzzle shape 

selected. Choose the one you like best from the best several fits displayed. 

Save

Save all the changes made to the puzzle.

Import 

If you have previously saved a list of Words and Clues to a .txt file, click on the Import button to start the import 

process. Load the words and clues from the .txt file directly into the program. 

Export 

Click on the Export button to export the words and/or clues to a .txt file. 

Add Words 

This option opens an editor that allows you to manually add words to the design of the generated puzzle. 

Close

Close the crossword editor window and return to the program's home window.
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Title 
Enter the name for the puzzle being created.  The name assigned displays on the puzzle page generated if you elect 

to include the Title in the page layout. The Title also appears in the Puzzle List found in the opening window of the 

program. 

  

Category 

Puzzles may be assigned to categories to help you more readily find a puzzle already created and saved. Categories 

may be set up by subjects, interests, dates, uses or any other method that will help you to quickly find a puzzle. 

As you enter a category in the blank field, it will be added to the drop down list. The next time you create a puzzle 

to place in the same category, just select it from the drop down list instead of retyping the entry. 

  

Enter a Word / Enter a Clue

To add words to a puzzle, click on the "Enter a Word" edit box. Type the word and press Tab to move to the "Enter a 

Clue" edit box. Add the clue and press Enter or click on the Add button to insert the word and clue into the existing 

list of words and clues. 

    

Used

This column indicates whether the word and clue are currently being used in the generated puzzle. A check 

mark indicates that the word and clue are included. If the puzzle has not been generated yet, then none of the 

boxes are marked, as in the example above.

Word 

The Word column lists the words to be included in the crossword puzzle. Click on the field beneath the Word 

header to add a new word. Or click on a word already in the list to edit that word. The maximum word length 

allowed is 30 characters. 

  

Clue 
The Clue column lists the clues associated with each word in the puzzle. Click on the field beneath the Clue 

header to add a new clue. Or click on an existing clue to edit that clue. The maximum clue length allowed is 150 

characters. 

 

Note: If editing an existing word or clue in the list, make sure to exit the edit field before clicking on Save or Create. 

Otherwise the change just made will not be saved.

  

Delete 

Highlight a word and clue, or several from the list. Click on the Delete button or press the Delete key on the 

keyboard to remove the highlighted words and clues from the puzzle.

Spell Check 

The Spell Check button activates the Spell Checker. The Spell Checking window opens if any words or clues do not 

match what is found in the spell checker library. You can select the correct spelling from the list of possible choices 

or indicate that the spelling is correct and proceed. If all words are found, then a message indicates that all is correct.

Thesaurus 

Select a word from the Words list and click on the Thesaurus button to open the Thesaurus Lookup window. 

Bonus Question 

The Bonus Question is primarily for educators. The bonus question would normally tie into the theme of the puzzle. 
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The Bonus Question is primarily for educators. The bonus question would normally tie into the theme of the puzzle. 

Possibly use the question for extra credit for those that answer it correctly. The question may be placed anywhere 

on the puzzle layout. This field holds up to 120 characters.

Note: In order for the Bonus Question to show on the completed puzzle, make sure the page layout you select 

includes the field for a bonus question. Or modify your page layout to include the bonus question. 

Word Count

The number of words listed are displayed after Save button is pressed.

Puzzle Appearance

The image displays the current puzzle layout and puzzle shape selected. It provides a general idea of what the 

finished puzzle will look like. 

Shape

Click on the Shape button to open the Shapes window that allows you to select a different shape for use in the 

puzzle being developed. There are additional options to create new shapes, or modify, delete and copy existing 

puzzle shapes. Also import or export puzzle shapes. 

Layout

Click on the Layout button to select a different page layout or modify the currently selected layout. Other 

options allow for creating new layouts and importing or exporting layouts.

Shrink Shape to Fit Puzzle

If the words do not fill the puzzle shape, you can use the Shrink option.  Select this option to shrink the puzzle 

shape to better accommodate the puzzle words. Press the Create button again to regenerate the puzzle.  Note: 

This option is best used with square or rectangular shapes. Otherwise only a portion of the original shape may 

be included in the finished puzzle. 

Show Letter Count in Puzzle Clues

Select this option to display in the printed puzzle the numbers of letters for each word. The number of letters in 

the word is displayed in parentheses next to the clue for that word.
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Created Puzzle 

Pressing the Create button from the Create New Puzzle window generates the puzzle. The four best fits display in 

this window.  Double click on any of the puzzle fits to zoom in on the puzzle. 

  

Crossw ord Construction Kit > New  Puzzle Button > Create Button

 

Included Words 

This list includes all the words that fit into the outlined or highlighted puzzle.  The number preceding "Included 

Words" indicates the number of words included in the puzzle. Select any of the Best Fits  to display the list of words 

included in the puzzle. 

  

Excluded Words 
This list includes all the words that did not fit into the outlined or highlighted puzzle. The number preceding 

"Excluded Words" indicates the number of words that did not fit in the puzzle. Select any of the Best Fits to display 

the list of words not included in the puzzle.

  

Save Puzzle 
Highlight the preferred puzzle fit and click on Save Puzzle. The puzzle is saved and listed in the Crossword 

Construction Kit window as available for print. 

  

Cancel 
If you don't like any of the puzzles created, then click on the Cancel button. Cancel returns you to the Create New 

Puzzle window to Create again or to make other changes. 
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Manually Add Words to Puzzles 

After creating a puzzle, you may attempt to fit additional words into the puzzle. Click on Edit | Puzzle Words from 

the Crossword Construction Kit window or click on the Add Words Directly button in the puzzle editor to open the 

Manual Word Addition window, as shown below.

Modify Existing Puzzle Window  > Add Words Directly

  

The blue squares represent the spaces where letters may not be added, as this would change the spelling of words 

already created in the puzzle. You may attempt to fit words in any of the black spaces. 

  

Adding Words 
Point the mouse at the empty square where you want to add a letter and click. Insert the letter into the box that 

appears. Either click on the Accept button to accept the letter or click the mouse anywhere in the window to insert 

another letter. Follow these steps until the new word is completed.

If you typed a letter incorrectly, highlight that letter and click on the Reject button. The letter is erased so that you 

can enter the correct letter. 

  

After ensuring the word is spelled and situated correctly, click on the OK button to open the Add a Clue dialog.

Add a Clue
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Word 

The word entered in the Manual Word Addition window is listed. Choose how the word is displayed in the puzzle 

editor window. 

• Upper Case

• Lower Case

• First Letter Cap

Clue
Enter the clue in the Clue field for the word listed. 

When finished press OK to save the change and return to the editor window. The new word and clue are now listed 

with the other puzzle words. To add another word, repeat the process by clicking on the Add Words Directly button.

Note: You may place multiple words in the puzzle and then click the OK button. The Add a Clue dialog box opens, 

allowing you to sequentially add the clues to all of the words manually entered. 
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Dictionary / Spell Checker 

The program provides eight dictionaries that may be used for spell checking words and clues. 

Dictionaries Available
Dutch

English (U.S.)

English (U.K.)

French

German

Italian

Spanish

Swedish

  

To change dictionaries, select Options | Preferences | Language from the  menu of the Crossword Construction Kit 

window. Click on the dictionary language preferred. Or click on the Choose at Spell Check Time option which allows 

you to select the preferred language at the time you are creating the puzzle. 

 

Optionally add words to the dictionary so that the spell checker includes them as valid words. Select Options | Add 

to Dictionary from the main menu to open a window displaying any words previously entered as valid. Add or 

delete words from this list as needed. 

  

Or exclude words from the dictionary so that the spell checker considers them as invalid words. Select Options | 

Exclude from Dictionary from the main menu to open a window displaying any words previously entered as invalid. 

Add or delete words from this list as needed.   

Activating the Spell Checker

When creating or modifying a puzzle, click on the Spell Check button to proof the spelling of words and clues. The 

spell checker begins with the first word and works its way through the word list. It then checks the spelling of the 

clues.

If there are no spelling errors a message appears stating that all words were found in the dictionary and the spelling 

is OK. If a word is not found in the dictionary, then a dialog box entitled Spelling Suggestions appears. The word in 

question is highlighted and displayed as shown in the example below. 

Crossw ord Construction Kit > New  Puzzle button > Spell Check  
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Suggestions 

A list of suggestions (possible correct spellings) for the word in question appear in the box. 

 

Change 
Highlight the correct spelling of the word in the suggestion box and click on the Change button. The correct 

word is inserted into the Word or Clue field and replaces the misspelled word. 

  

Ignore 
If you are certain that the word questioned by the spell checker is correct, click on the Ignore button. The word 

is bypassed and the spell checker continues searching for other words. 

  

Add 
If the word listed is not found in the spell checker, click on the Add button to add the word to the dictionary. 

The next time the word is used in a puzzle, the spell checker will skip over it and not slow you down. 

  

Cancel
Clicking on the Cancel button stops the spell check process and returns to the previous window. 
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Thesaurus Lookup 

The Crossword Construction Kit comes with an English (U.S.) or English (U.K.) thesaurus. The version you want can 

be selected by clicking on Options | Preferences | Language. Select the thesaurus you prefer. Or select Choose at 

Thesaurus Use Time, which will prompt you for the preferred thesaurus at the time you create the puzzle. 

  

The thesaurus is used while creating a new puzzle or modifying an existing one. Place the cursor on either the word 

or the clue and click on the Thesaurus button to open the Thesaurus Lookup window.

 

Create New  Puzzle w indow  > Thesaurus button

Looked Up

The word selected from the puzzle is inserted into this field. If you want to search on a different word, enter the 

new word in this edit field. 

Suggest 
The Suggest button is primarily used if the word you are looking for is not found in the thesaurus. Clicking on 

the Suggest button opens the Word Suggestions window as shown below.  It supplies a quick list of possible 

words. Highlight a word from the list and click OK. The highlighted word replaces the original word in the 

Looked Up field of the Thesaurus Lookup window. 

67



  

Look Up 
If you want to find a synonym for another word besides the original word  entered, delete the original word in 

the Word field and replace it with another. Click on the Look Up button to display a new set of synonyms.

  

Replace Word
Select a word from the synonym or antonym list to place it in the Replace With field. Click the Replace Word 

button to replace the original Puzzle Word with the new word selected from the Thesaurus. 

Replace Clue
Select a word from the synonym or antonym list to place it in the Replace With field. Click the Replace Clue 

button to replace the original Puzzle Clue with the new word selected from the Thesaurus. Use this option as a 

method to develop clues for words in the puzzle.

Cancel
Click Cancel to exit the Thesaurus without making any changes.

Meanings  

If the word has several distinct meanings, the various meanings will be displayed in this field. The highlighted word 

in the category list will display synonyms to the right in the Synonym field. Highlight another word in the Meanings 

list and another set of synonyms will appear from which you can select an appropriate clue. 

  

Synonyms 
This is the list of words with similar meanings to the word displayed in the Word field. Highlight the synonym to be 

used and it is displayed in the Replace With field. Or double click on a synonym and it replaces the original word in 

the Word field.

  

Antonyms 
The antonym field displays words with opposite meanings to the word displayed in the Word field. You can 

highlight one of the words in the antonym list and a list of words with opposite meanings displays in the synonym 

list. 
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Importing Puzzle Words and Clues 

Word lists may be created independently of the Crossword Construction Kit. Use a text editor to generate a list of 

words, clues or both. If using a list of words and clues, each word and clue must be listed on the same line and 

separated by a Separator Character such as a colon or semicolon.

From the Create New Puzzle window click on the Import button to open the Import window as shown below. 

 

 

Create New  Puzzle or Modify Existing Puzzle w indow  > Import Button

  

Items to Import   

The import window displays all of the words and clues which are available for import. Clicking on a word/clue will 

select it for import. Clicking on the word/clue a second time will remove the highlight. Click on the words you want 

to import and then click on the OK button to start the import process. 

Words
Select this option to only import the word list and not the clues. If importing a word list from the Word Search 

Construction Kit, you may only want to include the words.

Clues
Use this option if you only want to import the puzzle clues.

Word and Clues
This option imports both the words and clues.

Separator Character

This option is only available when the Words and Clues option is selected. Make sure that the same 

separator character matches what is in the text file. Otherwise it may not import correctly. In the image 

above, the separator character used in the text file is a colon (:), so you would need to insert a colon in the 

Separator Char field.  

Open File  
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Click on the Open File button to open the Windows dialog that allows you to select the text file containing the 

words and clues to import. Select the file and the words and clues are loaded into the list box as shown in the 

example above. 

  

Clicking on a word/clue highlights it and selects it for import. Clicking on the word/clue a second time removes the 

highlight. 

  

Select All 
Use this option to highlight all of the entries in the text file for import.  Otherwise just click on the words you want 

to highlight those to be imported. 

  

Clear 

This option removes the highlighting from all words and clues previously selected. At this point nothing is selected 

for import. 

  

OK  
Click OK to start the import of all selected words and clues and place them in the word/clue list of the Create New 

Puzzle window. 

  

Cancel 
This simply allows you to back out of the import word process if you decide not to import. 
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Export Puzzle Words and Clues 

It is possible to maintain the list of puzzle words and clues independently of the Crossword Construction Kit. These 

may be exported and saved to a .txt file.

 

 
Create New  Puzzle or Modify Existing Puzzle w indow  > Export Button

  

Items to Export 

The export window displays all of the words and clues which are available for export. Clicking on a word/clue will 

select it for export. Clicking on the word/clue a second time will remove the highlight. Click on the words you want 

to export and then click on the Save File button to start the export process. 

Words
Select this option to only export the word list and not the clues. If exporting to use with the Word Search 

Construction Kit, you may only want to include the words.

Clues
Use this option if you only want to export the puzzle clues.

Word and Clues
This option exports both the words and clues.

Separator Character

This option is only available when Words and Clues is selected. You are prompted to enter a character to 

separate the words from the clues in the exported text file. Typically a colon, semicolon or similar is used to 

mark where the word ends and the clue begins. 

Select All 

Click on the Select All button to highlight all words and/or clues for exporting.  

  

Select Used 

This option selects all words or words and clues that have been used in the puzzle. Any words or clues added that 

are not currently part of the puzzle will not be highlighted. 
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are not currently part of the puzzle will not be highlighted. 

  

Clear 

This removes the highlight from all the words and clues in the list box. Use this button if you want to start over in 

choosing the words and clues for export. 

  

Save File 
Clicking on the Save File button brings up a standard windows dialog requesting the name the file is to be saved as 

and in which folder to save the file. 

  

Exit 
This exits the export window and cancels any changes you may have made. 
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Puzzle Shape Editor 

  

Crossword Construction Kit comes with over 100 predefined puzzle shapes. In addition, you may create new shapes  

or modify existing ones. You can also import or export the shapes to/from others using the Crossword Construction 

Kit or Word Search Construction Kit. Highlighting the shape name and dimensions displays the puzzle shape in the 

grid to the right. 

Crossw ord Construction Kit >  Edit > Puzzle Shape or Create New  Puzzle > Shape Button

 

New 
Click on the New button to open the Shape Creator and begin designing a new puzzle shape. 

Import 
Use this function to import additional shapes.  Click on the Import button to open a Windows dialog that allows you 

to locate other puzzles shapes for import into the program. More details are provided in the Puzzle Shape Exchange 

topic. 

  

Export 
Select this option to export shapes. These may then be sent to friends, colleagues, etc.  Additional details are 

provided in the Puzzle Shape Exchange topic. 

Right Mouse Context Menu

Right mouse click on the the shape desired to view a menu of additional choices.

Modify 
Use this menu option to modify an existing shape. This action opens the Shape Creator window where 

modifications may be made to the layout. 
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Copy
Make a copy of an existing shape. This action opens the Shape Creator window and renames the shape with a 

(2) after the original shape name. You can rename the shape, make any changes to the shape and save. The 

original that you started with remains the same and another shape is added to the list.

Delete 
If a puzzle shape is no longer needed, select Delete from the menu to remove the highlighted shape. A prompt 

displays to verify that the deletion should occur. 

  

Select 

The Select button is only available when selecting a shape from the Puzzle Creation window. Highlight the shape 

desired and press the Select button. This action returns you to the previous window and the shape selected will 

now be used. 

  

Close 
Click close to exit and return to the previous window.
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Puzzle Shape Design 

The Shape Creator Window allows you to design a shape which can later be used with a puzzle. 

 

 
Crossw ord Construction Kit > Edit > Puzzle Shape > New  button

  

Title 
This is the name by which the layout will be known. The name is displayed with the other shapes found in the 

Puzzle Shape Editor window. 

  

Dimensions 

The dimensions allow you to specify the maximum width and height of the shape. The maximum grid size is 49 x 49 

blocks. 

  

Grid 
A Grid appears on the screen with the size specified by the width and height. The grid will contain black and 

sometimes white blocks. The puzzle is generated to fit in the black blocks. The white blocks represent empty space 

for the puzzle. Clicking on a block with the left mouse button toggles the color of that block between black and 

white. The right mouse button can be used as a "filler". 

For example, if a section is surrounded by white blocks, you may position the mouse inside that section on one of 

the black blocks. Click the right mouse button and the whole inside section will become white. As this can have 

disastrous results if used accidentally or if a whole area was not closed off, an "Undo" button is available which will 

undo the last "fill". 
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To learn more, see the Tutorial - Creating a New Shape topic.

Shift Grid 

The Shift Grid feature moves the grid up or down one row each time you click on the up or down arrow. The grid also 

moves one column to the left or right each time you click on the left or right arrow. Each click will add or delete a 

row or column from the grid, depending on which direction you click.

  

Adjust Grid

Reverse 
Pressing the reverse button will reverse the image you have created. The white areas of the original shape will now 

be black while the black areas will change to white. 

Undo
Click on the the Undo button to undo a Fill made in error or to undo an erroneous Shift made in the puzzle shape.

Save 
Press the Save button after completing the shape. The shape is saved and the Title given to the shape is listed in the 

Puzzle Shape Editor window with other shapes previously created. 

  

Cancel 
Press cancel to abort creating a shape and return to the Create New Puzzle window. 
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Puzzle Shape Exchange 

Puzzle shapes may be imported and exported. A special file structure (*.LAY) is used for importing and exporting. 

The Crossword Construction Kit and the Word Search Construction Kit both use the same file structure. These files 

are interchangeable between the two programs. As a result, you can create a puzzle shape in the crossword program 

and use it in the word search program. 

  

From the Crossword Construction Kit window click on Edit | Puzzle Shape to open the Shapes window. Then click on 

the Export button to open a standard Windows dialog. Select a name for the .LAY file and save to an accessible 

location.

From the Word Search Construction Kit import the shape by opening the Shapes window and click on the Import 

button. Retrieve the file from the location where it was saved. 

Or export from the word search program and import to the Crossword Construction Kit. 

  

You can also swap puzzle shapes and designs with friends and associates who use the Construction Kits. 
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Page Layout 

The Puzzle Page Layout window allows you to determine how the puzzle and its components will appear in print, in 

a playable puzzle or on a web page. A number of predefined page layouts come with the program. Of course, you 

can also modify existing layouts or create new ones. 

  

Crossw ord Construction Kit > Edit > Page Layout or Create New  Puzzle > Layout Button

  

The Edit box displays the names of the layouts currently saved to the program. It also displays the paper size 

associated with the layout. Highlight a page layout and its design is displayed to the right. The color coded keys 

show what each box in the design represents. The layout in Bold letters has been set as the default page layout. 

This is the layout that is selected by default each time a new puzzle is created.

New 

Click on the New button to open the Page Creator window and begin designing a new page layout. 

Import  / Export 

Puzzle layouts may be imported and exported. A special file structure (*.PAG) is used for importing and exporting. 

Click on the export button to open a standard Windows dialog box to choose a name and location for saving the 

export.

To import the layout, click on the import button and retrieve the file from the location where it was saved. The 

import and export function allows you to swap puzzle layouts with friends and associates who also use the 

Crossword Construction Kit. 

  

NOTE: Puzzle layouts do not embed bitmap, .jpg or .png images inside them. If you export a page layout and the 

layout contains an  image, then the recipient of the page layout will also need access to the image. The recipient 

will need to modify the layout so that it points to the folder where the image file is located. 

  

Extract 
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If someone exports a puzzle and sends it to you, you may decide that you want to use the page layout that came 

with the puzzle. To retrieve the layout, click on the Extract button to open the Extract Page Layout from Puzzle 

window, which displays a list of all puzzles in the file. Select the puzzle that contains the layout you want and click 

on the Extract button. This action returns you to the Puzzle Page Layouts window and the new layout is added to the 

existing list. The layout retains the name of the layout extracted from the puzzle. If desired, use the Modify option 

mentioned below to rename the layout.

 

Right Mouse Context Menu

Right mouse click on the layout desired to view a menu of additional choices.

Set Default 
When creating a new puzzle the program displays a default page layout. This is the layout that will be used with 

the puzzle unless a different layout is subsequently selected. Use this option to select which layout will be used 

as the default. The currently selected default layout is displayed with bold font.

Modify 
Use this menu option to modify an existing page layout. This action opens the Page Creator window where 

modifications may be made to the layout. Or double click on the layout to modify.

Copy
Make a copy of an existing layout. This action opens the Page Creator window and renames the layout with a (2) 

after the original layout name. You can rename the layout, make any changes to the it and save. The original 

that you started with remains the same and another layout is added to the list.

Delete 
If a layout is no longer needed, select Delete from the menu to remove the highlighted layout. A prompt 

displays to verify that the deletion should occur. Or press the Delete button on the keyboard to remove the 

highlighted layout.

  

Select 

The Select button is only available when selecting a page layout from the Puzzle Creation window or choosing to 

override a page layout from the Print Options window. Highlight the page layout desired and press the Select 

button. This action returns you to the previous window and the page layout selected is used. 

  

Close 

Click close to exit and return to the previous window.
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Page Creator 

This window allows you to design and place the components of the puzzle anywhere on the page. Select which 

components you want to use, drop them where you want them and stretch the components to the size you want. 

A number of options are available for each puzzle component. Right clicking on any component in the layout section 

opens a context menu of options available for that component. Or left click on the Objects button and select the 

component to be edited. 

 Crossw ord Construction Kit > Print Puzzle > OK   

       

Name 
In this field assign a name to the layout design you are about to create, to distinguish it from others already 

developed. 

  

Paper Size 

A drop down list of paper sizes allows you to select the size of paper that you will design the layout on and 
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A drop down list of paper sizes allows you to select the size of paper that you will design the layout on and 

ultimately use for print. You can choose between legal, letter, A4, A5, B5, Executive and custom sizes.

Select either Portrait or Landscape to choose the paper orientation you prefer. 

Custom Paper Size

Selecting Custom Paper Size displays additional fields for specifying the paper width and height in centimeters. 

Or select the Inches check box to specify the width and height in inches. NOTE: Some printers will not support 

custom paper sizes. Results may vary. 

  

Crossword Objects 

The following crossword objects may be included in the page layout: Title, Puzzle, Across Heading, Down Heading, 

Across Clues, Down Clues, Word List, Bonus Question and Combined Clues. Each of these items may only be used 

once in the layout. A description of the available items is listed below:

Title - The name assigned to the puzzle is placed within the title box. 

Puzzle - The actual crossword puzzle and shape is placed inside the puzzle box. 

Across Heading - This box contains the heading for the Across clues. 

Down Heading - This box contains the heading for the Down clues. 

Across Clues - All of the Across clues are placed in this box. 

Down Clues - All of the Down clues are placed in this box. 

Word List - This object displays all of the puzzle words used in the puzzle. 

Bonus Question - Use this object to include a bonus question with the puzzle. 

Combined Clues - The Combined Clues combines the Across Heading and Clues and the Down Heading and 

Clues into one component. The position for Headings and Clues will be adjusted automatically within the 

component. 

Other Objects 
In addition to placing puzzle components on the layout, you may include text fields, images, rectangles or circles. 

Note: More than one of each of these items may be inserted into the layout. However, there is a maximum of 

twenty crossword and other object items that may be used in a single layout.

Text - This free form field provides a place to insert any text comments, rules, explanations, etc. After 

adding the text box to the layout, right mouse click on the box in the layout. From the context menu, left mouse 

click on Change Text and enter the text into the edit box that opens. 

Image - Insert a bitmap, .jpeg or .png image onto the page layout to enhance the overall look of the puzzle. 

You may want to lay a skeleton puzzle over the top of an image for a special effect. 

Rectangle/Circle - Place rectangular or circular patterns in the page layout. Insert a colored rectangle or 

circle beneath one of the Crossword Objects to provide a color contrast if printing the puzzle in color.

See the Tutorial - Creating a Page Layout help topic to learn more about creating a new layout.

Placement and Sizing of Objects

To place an object on the paper size you selected, first click on the icon, such as Title. Next, move the mouse to the 

paper grid and click the spot on the grid where you would like the puzzle Title to appear. A small box with the word 

Title is placed on the grid. Also note that the Title icon has been "grayed" out, indicating that you can not add a 

second title to the layout. 

  

Click on the Title box within the grid and it will be outlined with small squares in the corners and midpoints of each 
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Click on the Title box within the grid and it will be outlined with small squares in the corners and midpoints of each 

line. With the mouse pointing inside the box, the cursor changes to the symbol of a hand. While the hand symbol is 

displayed, hold down the left mouse button and move the mouse. The box will follow the movement of the mouse. 

You can reposition the box to any spot on the grid. Release the mouse button when you have the box positioned 

correctly. 

  

To resize the object, point the mouse to one of the small squares in the corners or midpoints of each line. Pointing 

at one of these squares will change the mouse pointer into a double-sided arrow. When the double-sided arrow 

appears, hold down the left mouse button and move the mouse. 

  

Moving the mouse away from the box will enlarge it, while moving toward the center of the box will decrease the 

size. Resizing from the corners will either increase or decrease the box height, width or both, depending on which 

direction you move the mouse. Resizing from the midpoints of the top or bottom lines will adjust the height of the 

object. Sizing from the midpoints of the two vertical lines will adjust the width of the object.

Small, Medium, Large

Click on these buttons to see different size views of the layout.

Save 

Click on File | Save or the Save icon to save your work. The new layout will now be listed in the Puzzle Page Layouts 

window with the title you provided. 
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Page Creator Objects Menu 

  

Objects 
Click on the Objects icon in the Page Creator to provide a drop down list of items that correspond to the objects that 

are currently placed in the design layout. If there are no components in the design layout, the Objects icon is grayed 

out.

  

If components have been added to the design layout, click on the Objects icon to view a menu composed of each of 

the components added to the layout. The menu items may include Title, Down Clues, Across Clues, Puzzle, etc. Click 

on one of the items in the list and a menu of options for editing that component is displayed. (Or right mouse click 

on any of the components in the layout to access the same menu.)  

The menu options are described below. NOTE: Some options will be grayed out if they do not apply to a particular 

object. 

 

Size & Position 

With this option you can be more precise (than with the mouse) in the sizing and positioning of objects. Clicking on 

this option will bring up a pop up window which contains four values, the position of the object from the top and 

left side of the paper and the height and width of the object. Each or all of these values may be changed. Depending 

on the paper type selected, the values will either be in inches or centimeters. 

 

 

Left - Position the object a specified distance from the left edge of the paper. If the value in this field is 2, and 

we’re using inches, the left edge of the object will be placed 2 inches from the left edge of the paper. 

Top - Position the object a specified distance from the top edge of the paper. If the value in this field is 2, and 

we’re using inches, the top edge of the object will be placed 2 inches below the top edge of the paper. 

Width - Specify the width of the object. 

Height - Specify the height of the object. 

Border 

Place and size borders around all components except the puzzle itself. 

  

Use Border - Select this option to place a border around the component. In the example above, it would place 

a border around the Across Clues. 

Width - If the Use Border option is selected, enter a value to adjust the width of the border. The value is in 

pixels. 

Border Color - If the Use Border option is selected, click on the Change Color box to select another color to 

outline the component. 

Fill 
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If any circles or rectangles have been placed in the layout, this option allows you to select a color to fill the shape.

 

  

Fill In Shape - Selecting this option fills the shape with a color that you select. 

Fill Color - Click on the Change Color box to select a color to fill the shape. 

Order

Bring to Front 
This option brings a component that was in the background to the forefront so that it is on top of other objects. 

Send to Back 
This option sends a component that was on top of other objects to the background. 

Change Text 

Selecting the Change Text option will allow you to edit the text in certain layout components. A pop up window will 

appear with your current text inside the box, where you can edit the text and make any changes. After making the 

changes, click on the OK button to save changes or click Cancel to exit. 

  

The only components editable with this option are the Down Header, Across Header, and the free form text area. 

The Down and Across Headers are primarily changed for non-English language support. The Down and Across 

headers may be permanently changed in the Preference settings, so that all new layouts will default to the new 

text. 

Text Alignment 
Selecting Text Alignment provides a choice to align the text to the left, center or right. Select the option preferred 

and the text is realigned. The components that may be aligned are Title, Down Header, Across Header, Bonus 

Question and the freeform text area. 

  

Text Font 

Selecting Text Font opens a standard Windows dialog allowing you to select the font type, style, size, color and 

effects. The components that allow this option are Title, Down Header, Across Header, Across Clues, Down Clues, 

Word List, Bonus Question and the freeform text area. 

  

Answer Key Font 

Using the Answer Key Font option will allow you to change the font type, style, size, color and effects for the hints 

placed in the puzzle or the entire answer key. 

  

Clue Number Font 
Use this option to modify the down and across numbers of the puzzle.
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Change Font - Click on the Change Font button to open a standard Windows dialog that allows you to select the 

font type, style, size, color and effects. 

Orientation - The orientation area allows you to select whether to position the clue numbers horizontally or 

vertically.

Load Image 

Click on this option to load a bitmap, .jpg or .png image into the Image component of the layout. This action opens 

the Load Image File window where you can locate the correct image to load. 

  

Delete 

This option deletes the layout component highlighted and removes it from the layout. 

 

Properties for Text Objects 

The properties for text objects include the following two options, Transparent Background and Make It Fit. The 

Across Clues, Down Clues, Combined Clues and Word List objects also allow you to specify the number of columns 

to use. 

  

Transparent Background 

The Transparent Background option makes the background of the object transparent and any color you may 

have assigned to the background will not appear. This option is useful for laying text on top of an image. 

  

Make It Fit 

The Make It Fit option auto sizes the font so that all the text will fit into the box size you selected. NOTE: The 

make it fit option will only shrink the font to make it fit, but not enlarge it. If you want the tightest fit, select a 

large font size and use the make it fit option.

Number of Columns

Determine the number of columns for the Across Clues, Down Clues, Combined Clues and also for the Word List.
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Split Columns

This option is only available with the Combined Clues component. Select Split Columns to have the Across and 

Down clues displayed in separate columns. Otherwise the Across and Down clues will display consecutively, 

overlapping in the same column.

Properties for Puzzle Component 

The Properties for Puzzle dialog provides options for editing various visual aspects of the puzzle component. These 

are described below. 

Skeleton Puzzle - Create a skeleton puzzle. Only the blocks with letters will appear, not the unused fill boxes. 

This is ideal for laying over the top of graphic images or to save ink if printing many copies.

Puzzle Fill Color - Click on the Change Color box to select a fill color for the puzzle. This option is not available 

with a skeleton puzzle. 

Puzzle Block Color - If you want the blocks that contain the letters to be a color other than white, click on the 

Change Color button and select a new color. 

Puzzle Line Color - Click on the Change Color box to select another color to outline the lettered squares. 

Puzzle Line Width - To widen the lines around the boxes, increase the value from one to create a thicker line. 

Properties for Image

The Properties for Image dialog displays the location of the image file saved to the page layout. To change the 

location click on the Load Image menu option to select a new image.
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Page Creator Tips

     

How to place an image behind a puzzle

Follow the steps below to include images as backdrops behind your puzzles.

Sample puzzle w ith image backdrop

To start, first open the Crossword Construction Kit window and click on Edit > Page Layout. Or if editing a puzzle 

double click on the Layout button to open the Puzzle Page Layouts window. 

1. Choose the page layout that you want to use and double click on it to open in the Page Creator window.

2. Click on the Image icon from the right hand column of choices.

3. Click on the Puzzle box inside the existing layout to insert a smaller white Image box.

4. Resize the Image box by dragging the edges to match the size of the Puzzle box and completely cover it.

5. Right click on the image box and select Load Image from the menu options.

6. Browse to the image file on your computer that you want to use and select it.

7. After it is selected, right click again on the Image box and choose Order > Send to Back to place the image 

behind the puzzle.

8. Right mouse click on the Puzzle box and select Properties from the menu.

9. Select the Skeleton Puzzle option and save.

When you view or print the puzzle, the image will display behind the puzzle as illustrated in the example above.

I sent a puzzle page layout I created to a friend who also uses the Crossword Construction Kit. When 

the layout was opened, the image was missing. Why? 

Images are not embedded into the puzzle layouts. If you export a page layout and the layout contains a bitmap or 

other type image, the recipient of the page layout will also need access to the image. The layout looks for the 

location on your computer where the image is stored. In essence you need to send both the layout and the image 

file. They would then have to link the image to the layout. 

  

How can I create a two page layout? 

You would need to create two separate page layouts. For example you can place the puzzle and title on one of the 

page layouts. Then create another layout that would contain the down/across clues and headers along with any 

other text components you may want to place on the page. After you have designed the two layouts, print each one 

separately. The puzzle will print on page one and the clues on the following page. 

    

While creating a page layout I was using the Size and Position option to position an object on the 

page. I accidentally typed in a value that positioned the object off of the page and now can't right 

click on it to reposition. What should I do? 

Let's say that you positioned the Title off of the page layout. Since it's off the page, you cannot right click on the 

object to open the menu options. The Title button has been grayed out so you can't just place another title object 

on the page. But you do have the option to click on the Objects button and select Title from the list of objects that 

you've already added to the page layout. The menu options for Title will appear where you can select Size and 

Position to correctly reposition the Title. 

      

How can I enlarge the squares of the puzzle? 

The answer to this depends on a couple of factors. These include the puzzle shape chosen and the size of the Puzzle 
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The answer to this depends on a couple of factors. These include the puzzle shape chosen and the size of the Puzzle 

Object on the page layout you are using. The puzzle shape expands to fill the area designated for the puzzle on the 

page layout. Let's examine how the puzzle shape first impacts the squares on the puzzle. 

  

When you create a puzzle, you have the option to select a Puzzle Shape by clicking on the Shapes button. You can 

choose squares, triangles, circles, cars and a variety of other shapes for the puzzle. Let's compare a puzzle shape of a 

10 x 10 square to that of a 20 x 20 square. In each case, the puzzle will fill the exact same area on the printed page. 

However, the 10 x 10 puzzle will have bigger squares because there are squares for the same amount of space. So, 

the larger the dimensions of the puzzle shape, the smaller the puzzle squares will be. 

  

The second factor is decided by the page layout selected. The larger the area for the puzzle in the page layout, the 

larger the puzzle squares will be. The program comes with a few predefined page layouts, but you can also create 

any number of additional layouts. You can determine where to place the puzzle and its size.

The Creating a Page Layout tutorial in the help file walks through the process of designing a layout. A video on our 

website also demonstrates how to do this.

  

How can I print out a list of puzzle words on the same page as the puzzle? 

Create (or modify) a new page layout and add the Word List crossword object to the page layout. You can create, 

modify or copy a page layout by choosing Edit | Page Layout from the menu of the Crossword Construction Kit 

window. 

  

How can I make my fonts bigger for the clues, word lists or any part of the printout? 

The following instructions, for the most part, can apply to any of the puzzle objects. There are 3 or 4 factors involved 

in this process. Each requires the modification or creation of a new Page Layout. So let's use the Word List as our 

example. 

  

The factors for the Word List will be the physical size of the object on the Page Layout, the actual font size chosen, 

the Make It Fit (Auto Shrink Font) option and number of columns used. While in the Page Layout Designer, each of 

these factors can be modified by right clicking on the Word List object and selecting the appropriate menu item. 

• The size of the object can be changed using the Size & Position menu option. 

• The font size can be changed using the Text Font menu option.

• The Make It Fit and the Number of Columns can be changed using the Properties menu option. 

We'll examine how these factors all interact. The most obvious is the Size factor. The larger the area you provide for 

the word list, the larger potential font size you can use. 

  

However, the other factors also make a definite impact. So let's next look at the Font Size itself. Here you can 

specify the size, color, style, etc of the font to be used. So you choose a font size of 20. But how do you know if that 

font is too big or small to be used in the designated area? This is where the Make It Fit option comes into play which 

is a default value. 

  

The Make It Fit option will ensure that your text will fit in the area you have designated. It does so by first using the 

font you have selected and continually shrinking its size until it fits in the area specified. If you do not use this 

option, then the font size selected will be inserted. However, you run the risk of the font being too large and if it is, 

some of the words will not appear because they do not fit in the designated area. We recommend that you use the 

"Make It Fit" option in most instances. 

  

The last factor here is the number of columns. The default is set to a single column. So if the area (size) where you 

are placing the word list is not a long vertical strip, but a horizontal area, you will want to increase the number of 

columns. 

  

In summary, for the best results, you will want to do the following:

1. Choose an adequate size to hold all the words.

2. Choose an adequate number of columns to use based on the size.

3. Choose a very large font size. 
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4. Choose the Make It Fit (Auto-Shrink Font) option. 

How can I make my changes such as font size, colors, etc. permanent? 

Font sizes, colors, etc. are all tied directly to the Page Layout and the values are saved permanently with the Page 

Layout. So to make permanent changes, you need to modify or create a Page Layout. To associate your newly 

created or modified page layout with an existing puzzle, double click on the puzzle of choice from the Crossword 

Construction Kit window. On the resulting screen, click on the Layout button. Next highlight your puzzle layout you 

just created or modified and click on the Select button. And finally click on the Save button. 

  

If you modified a Page Layout that is associated with an existing puzzle, you still need to associate the new 

modified Page Layout with the puzzle. The puzzle maintains the old information until the change has been saved. 

The Print window provides an area where you can Override the Page Layout, Fonts, etc. These Puzzle Overrides are 

temporary and only affect the puzzle for the current print job. 
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Printing a Puzzle 

To begin the print process, click on File | Print Puzzle or click on the Printer icon. The following Print window 

appears. This window allows you to override various puzzle components before printing, adjust fonts and print 

answer keys.

   

Puzzle Overrides 

Crossw ord w indow  > Print Puzzle Button

If desired, use this window to override some of the settings previously defined  in the puzzle. If no changes are 

required, simply click OK to continue. Note: The overrides are for the current print job only. The values selected will 

not be saved as a permanent modification to the puzzle. 

• Page Layout - Select this option to open the Puzzle Page Layouts window to select another page layout, 

modify the layout in use or begin designing a new one. 

• Fonts - Click on the Fonts button to view a selection of puzzle components that may have the font types, 

sizes and colors altered. The puzzle components that may be altered are: 

Title 

Puzzle Answer Font

Puzzle Clue Numbers

Down Clues

Down Header

Across Clues

Across Header

Select the item to be altered. A standard Windows font dialog opens allowing you to make the changes to 

the current font selection. 

• Box Color - Click on the Box Color button to open a standard Windows color palette box. Select the color of 

the filled boxes from this window. The filled boxes are the boxes not used in the puzzle that fill in the 

shape that is selected.

• Across Header - This option is primarily for foreign language support. Change the Across clue header to 

display other text in the puzzle. This text may be permanently set from the main program window in 

Options | Preferences | Clue Headers. 
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• Down Header - This option is primarily for foreign language support. Change the Down clue header to 

display other text in the puzzle. This text may be permanently set from the main program window in 

Options | Preferences | Clue Headers. 

• Bonus Question - Type a bonus question in the edit box. Note: The bonus question will only display in the 

printed puzzle if the page layout includes space for the question. 

• Skeleton Puzzle - Selecting this option will print the puzzle without the filled (solid) boxes. Only the box 

outlines where letters are to be placed will be shown. With the filled boxes not present, this minimizes the 

effect of using a shape. A skeleton puzzle is useful if you want to place the puzzle over the top of an image 

such as a bitmap, or a circle, square or rectangle or to just save on toner if printing. 

  

Parts to Print 

Crossw ord w indow  > Print Puzzle Button > Parts to Print

The main components of the puzzle are listed in this area. A check mark beside each component means that they 

will be included in the printed output. To exclude one of the components on the printed puzzle, just remove the 

check mark next to the item to print. 

  

Note: If the Page Layout assigned to the puzzle does not include a component, such as Bonus Question, then it will 

not appear on the printed puzzle even though the item is selected in this list. 

Answer Key Options 
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Crossw ord w indow  > Print Puzzle Button > Answ er Key

• Answer Key - The Answer Key option prints the puzzle with all the answers filled in the crossword. When 

this option is selected the other options are not allowed.

• Partial Answers - Use this option to choose one or several answers to be filled in the crossword. After 

selecting this option, click on the Select button to display a list of all the words in the puzzle. Click or 

highlight the words in the list that you want displayed in the puzzle and click OK to save. 

• Partial Letters - This is another hint option that may be utilized. In the edit box, insert the letters that you 

would like to have shown on the printed puzzle. For example, type in the letter "e" and every letter "e" in 

your word list appears on the printed puzzle. 

OK

Click OK to open the Puzzle Preview window where you can view the puzzle to make sure that all your settings are 

correct, before the final print or image export. 

 

Cancel

Click Exit to close the Print window and return to the window where you were previously working. 
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Puzzle Preview and Print 

This page provides a preview of the finished product. From this window you can print the puzzle, save it to an image 

file in several different file formats or export to html. 

 
Crossw ord Construction Kit > Print Puzzle Button > OK

Print Puzzle

Click on the Print button to select the printer and number of copies to print.

  

  

Save Image
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Select this option to save the puzzle to an image file. A standard window dialog opens allowing you to name the file 

and select the location to save the file. A drop down list allows you to select from five different image file types as 

shown below.

• Bitmap (.bmp)  

• JPEG (.jpg)

• PNG (.png)

• Metafile (.wmf)   

• Enhanced Metafile  (.emf)

Note: The dimensions of the bitmap, JPEG or PNG file saved are directly related to the image being previewed on 

the screen. For example, a "zoomed in" image in the Preview window will produce a larger bitmap image. 

Copy to Clipboard 

Use this option to copy the entire puzzle page to the Windows clipboard. The image is copied in a bitmap format. 

When using this option, the following dialog appears prompting the width (size) of the image to be copied to the 

clipboard. Enter the pixel width desired and press OK to copy the image to the clipboard.

  

  

Save Text  

This option provides a method to save the words used in the puzzle or the clues to a .txt file.

Words 

Export the words used in the puzzle to a .txt file. 

  

Clues 
Export the clues of the words used in the puzzle to a .txt file. The numbering of the clues is retained so that the 

text may easily be ported for use in another application. An example of the text file is illustrated below.
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ACROSS

1. South Carolina

4. Montana

10. Massachusetts

14. Connecticut

15. Nevada

16. Rhode Island

18. Iowa

19. New York

21. New Hampshire

24. Oklahoma

25. Ohio

27. California

29. Maryland

30. New Jersey

31. Illinois

33. Tennessee

34. Louisiana

35. Alabama

37. Mississippi

39. Arkansas

41. Wisconsin

42. Hawaii

43. Georgia

44. Oregon

45. Vermont

46. Alaska

47. Florida

DOWN

2. North Carolina

3. Wyoming

4. Missouri

5. Texas

6. Michigan

7. Washington

8. West Virginia

9. Colorado

10. Minnesota

11. South Dakota

12. Utah

13. Nebraska

17. Idaho

19. North Dakota

20. Delaware

22. Pennsylvania

23. Kansas

26. Indiana

28. New Mexico

32. Kentucky

36. Maine

38. Virginia

40. Arizona

Save Web

Click on this button to create a printable puzzle for posting on a web page or a playable puzzle ready for uploading 

to a web site.

A Printable Puzzle web page contains a puzzle that can be printed from your website.  A Playable Puzzle Page 

contains a puzzle that may be solved on the website.  Letters are entered into the boxes on the page.  Buttons allow 

you to check your work or display the puzzle with the answers filled in.
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View 
There are several options for viewing (changing the view) of the created puzzle.

Zoom Page Width 
This option sizes the puzzle so that the width of the puzzle fills the Puzzle Preview window. It retains the puzzle 

in proper proportion.

Zoom Whole Page 
This option reduces or enlarges the image so that the entire puzzle may be viewed on the screen without the 

need to scroll. 

Zoom In or Out
Use the Magnifying glass images to either zoom in or out on the puzzle image. The zoom function moves in 

increments of 10%. The range varies from 10% of the original size up to 200% of original size. Or use the slider 

bar to zoom in and out on the puzzle image.

   

Zoom % 
By selecting one of the view options mentioned above, the percentage of the view size is displayed in this 

field. Or manually type a percentage of the view size into this field. This field accepts entries of 10% through 

200%. Press Enter to make the change. 

  

Pixel Width 
When a zoom size is selected, this field displays the width of the adjusted puzzle in pixels. 
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Create Printable Puzzle Page 

Quickly create the puzzle in HTML format to place on a web site. 

Puzzle Preview  > Save Web > HTML Creation

  

Web Page Title 

Type in the name of the web page in this field. This does not show up on the actual page that users will see. This is 

the field that search engines will typically search on. 

Puzzle Author

You can include the name of the person who created the puzzle in this field or just leave the field blank. 

  

First Header/Second Header 

Type text, up to 1,000 characters per field, into the two header fields provided. These can be used for whatever 

purpose you choose. You can elect to utilize all, none or some of these fields. Click on the Font button to select font 

type, color, size, etc. Keep in mind that not all font types will display in .htm format. Click on the check box to have 

the headers centered on the page. If you are familiar with HTML commands, you can embed them within the header 

fields. 

Puzzle Options

These options affect the actual puzzle image that will be displayed on the web page.

Top Horizontal Line
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Select this option to place a thin horizontal line on the page above the puzzle image. It is used to separate the 

headers from the puzzle itself.

Center Puzzle Horizontally
This option places the puzzle image in the center of the page. When a user widens or shrinks their browser 

window, the puzzle image remains in the center - left to right.

Bottom Horizontal Line
Select this option to place a thin horizontal line on the page below the puzzle image. It is used to separate the 

footers from the puzzle itself.

Width of puzzle image (in pixels)
Set the size of the puzzle image that will display on the web page. The default setting is 640 pixels wide. 

 

First Footer/Second Footer

Type text, up to 1,000 characters per field, into the two footer fields provided. These can be used for whatever 

purpose you choose. You can elect to utilize all, none or some of these fields. Click on the Font button to select font 

type, color, size, etc. Keep in mind that not all font types will display in .htm format. Click on the check box to have 

the footers centered on the page. If you are familiar with HTML commands, you can embed them within the footer 

fields. 

Playable
Click on the Playable button to toggle between the options to create a static puzzle web page or a playable puzzle 

web page.

Printable
Click on the Printable button to toggle between the options to create a static puzzle web page or a playable puzzle 

web page.

Template
View the .htm template for the puzzle. The template may be edited in the Template Editor.

Create Page
After selecting headers, footers and other settings click on the Create Page button. Both an HTML file (.htm) and 

JPEG file (.jpg) will be created and saved with the name assigned. Both of these files must be uploaded to the same 

directory in order for the puzzle to work correctly on the web site. 

View Page
After creating the page, click on the View Page button to open your default browser and view the .htm page just 

created. 

Close 

Click on the Close button to exit the window and not save any changes.
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Create Playable Puzzle Page

Export an interactive Java based puzzle to place on a web page.  Web visitors can play and solve the puzzle online. 

Note: For best results, create the puzzle using a horizontal page layout. This will minimize or do away with the need 

for the user to scroll up and down in the browser to solve the puzzle.

Puzzle Preview  > Save Web > Playable button

  

Web Page Title 

Type in the name of the web page in this field. This does not show up on the actual page that users will see. This is 

the field that search engines will typically search on. 

  

Puzzle Author 

You can include the name of the person who created the puzzle in this field or just leave the field blank. 

First Header/Second Header 

Type text, up to 1,000 characters per field, into the two header fields provided. These can be used for whatever 

purpose you choose. You can elect to utilize all, none or some of these fields. Click on the Font button to select font 

type, color, size, etc. Keep in mind that not all font types will display in .htm format. Click on the check box to have 

the headers centered on the page. If you are familiar with HTML commands, you can embed them within the header 

fields. 
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Puzzle Options

The default settings for all of the puzzle options, except the Center Puzzle Horizontally option, are defined in the 

Puzzle Player preference panel. 

Center Puzzle Horizontally

This option places the puzzle image in the center of the page. When a user widens or shrinks their browser 

window, the puzzle image remains in the center - left to right.

Show the 'Check Puzzle' Button

This button lets you know if the highlighted word in the puzzle has been entered correctly or not. A red X is 

displayed over top of any incorrect letters. Correct entries are left untouched.

Show the 'I Give Up' Button

Click on this button to display all of the answers for the puzzle.

Show the game timer 

A timer starts once the page is opened, displaying how long it takes to solve the puzzle. The timer stops when 

the puzzle is solved, showing the number of minutes and seconds required to solve the puzzle. Select this 

option to display the timer.

  

Disable sound effects 

By default the program plays back various sound effects for different actions taken during the solving of the 

interactive puzzle. The actions are described below in the Sounds section of this help topic. Check this box to 

disable all sound effects for the puzzle. 

Width of puzzle image (in pixels)

Set the size of the puzzle image that will display on the web page. The default setting is 640 pixels wide.  

Sounds

If the sound effects are not turned off, the following sound types may be used during the playback of the puzzle. 

The default sound settings are defined in the Puzzle Player preference panel. 

Winner Sound

When the puzzle has been solved correctly the winner sound plays back.

Did not Win Sound

If the puzzle was not solved completely and the I Give Up button is clicked, then the Did not Win .wav file plays.

  

Right Answer Sound

When the user clicks on the Check Puzzle button and there are no errors in the entries, the right answer sound 

file plays. 

Wrong Answer Sound

When a word is entered incorrectly and the user clicks on the Check Puzzle button, the selected wrong answer 

sound file plays.

Click on the drop down list to select a sound. Choose to have the program randomly play back one of the sounds 

available. Or select no sound, the built-in sound or choose another sound from the drop down menu. Click on the 

button next to the sound to listen to that sound.

First Footer/Second Footer

Type text, up to 1,000 characters per field, into the two footer fields provided. These can be used for whatever 

purpose you choose. You can elect to utilize all, none or some of these fields. Click on the Font button to select font 

type, color, size, etc. Keep in mind that not all font types will display in .htm format. Click on the check box to have 
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type, color, size, etc. Keep in mind that not all font types will display in .htm format. Click on the check box to have 

the footers centered on the page. If you are familiar with HTML commands, you can embed them within the footer 

fields. 

Playable

Click on the Playable button to toggle between the options to create a static puzzle web page or a playable puzzle 

web page.

Printable
Click on the Printable button to toggle between the options to create a static puzzle web page or a playable puzzle 

web page.

Template
View the .htm template for the puzzle. The template may be edited in the Template Editor.

Create Page
After selecting headers, footers and other settings, click on the Create Page button.  The template file determines 

what the Printable Puzzle web page looks like.  Information about the puzzle, such as the title, headers, footers and 

the puzzle itself, are merged with the template file to create the main .htm web page file.  Several files are created. 

The number and type of files created will vary depending on the options you choose.  All files, such as the ones 

listed below, must be uploaded to your web server for the puzzle page to work correctly.

• puzzle.htm – This is the main HTML puzzle file.

• puzzle.cw3 – This file contains the crossword puzzle. It has the same filename as the main HTML puzzle file 

but has a different file extension.

• crossword.jar – This java applet is called by the main HTML puzzle file, displays the puzzle and allows for 

puzzle interaction.

• sound.wav – One or more files containing the sounds used by the puzzle may be included. 

• image.png – Images used in the puzzle layout are copied as separate image files.

Note: The file names listed above are generic names. They will differ depending on the puzzle name selected, 

sounds chosen, and images used.

In order for the puzzle to work correctly on the web site, we recommend that you upload all of these files to the 

same directory. If you choose to put the files in different directories you will need to update the file paths. The 

paths must be relative to the main .htm puzzle page.

When ‘Surprise me’ is selected for a sound, the program chooses an appropriate sound when the Playable Puzzle 

Page is created. The sounds used do not change once the puzzle has been created and uploaded to your website.

Java is required on the end user's computer to solve a puzzle.

View Page
After creating the page, click on the View Page button to open your default browser and view the .htm page just 

created. Note: For testing purposes, the applet will not work on the local machine if it is located in a folder that 

contains spaces in the folder name.

 

Close 

Click on the Close button to exit the window and not save any changes.
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Templates

A template is used to create either a playable or printable puzzle.  Information about the puzzle, such as the title, 

headers, footers and the puzzle itself, are merged with the template file to create a web page. Separate template 

files are used when creating Printable or Playable web pages. 

Simple templates are included that allow you to create either playable or printable web pages. You may modify 

these templates using the included HTML Template Editor or using your favorite HTML editor.  Editing the template 

allows you to create puzzle web pages that match your website. Different template files may be used by entering 

the path and filename of the new template files in the Preference settings.

Puzzle Preview  w indow  > Save Web > Template

The template includes tags that are replaced by information from the Create Puzzle Page dialog. For example, the 

tag <!---#FIRSTHEADER#---> will be replaced with content from the First Header field.  You may move the tags 

around within the template as needed. If you remove a tag, the information corresponding to that tag will not be 

included in the web page that you create.  

Care should be taken when modifying the playable template or when changing the template files.  Improper 

changes may cause the playable puzzle to not function or the printable puzzle to not display.

See the Using HTML Templates tutorial for additional information.

Save

Click on the Save button to save any changes made to the template.

View Page
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Click to view the template created in a browser. A puzzle is not displayed when viewing the template from within 

the Template Editor. Unless you have made changes to the template, viewing it will display a blank page. Changes 

that you make to the template to match your web site will be visible when viewing the template.

Close

Click to close the Template Editor.

Below is a list of valid tags. Some tags are included for future use.

                                                                    

Tag Tag Description

<!---#GENERATOR#---> Generator meta tag

<!---#AUTHOR#---> Author of puzzle

<!---#TITLE#---> Title of puzzle

/*---#FHEADER#---*/ Location of CSS style for First Header

/*---#SHEADER#---*/   Location of CSS style for Second Header

/*---#PUZZLE#---*/ Location of CSS style for Puzzle

/*---#FFOOTER#---*/ Location of CSS style for First Footer

/*---#SFOOTER#---*/ Location of CSS style for Second Footer

<!---#FIRSTHEADER#---> First Header

<!---#SECONDHEADER#---> Second Header

<!---#CROSSWORD_APPLET#---> Name of applet that runs to play the puzzle

<!---#JARFILE#--->    Crossword.jar

<!---#WIDTH#---> Width of puzzle

<!---#HEIGHT#---> Height of puzzle

<!---#FILE#---> <!---#PN_FILE#--->   Pathname to the crossword puzzle file 

<!---#PN_NOSOLVE#--->   Parameter to turn the Check Puzzle button on or off

<!---#PN_NOGIVEUP#--->    Parameter to turn the I Give Up button on or off

<!---#PN_NOSOUND#--->  Parameter to turn off all sounds

<!---#USETIMER#---> <!---#PN_USETIMER#--->  Parameter that indicates whether the timer should be displayed while 

the puzzle is being solved

<!---#WINSOUND#---> <!---#PN_WINSOUND#---> Filename of the sound file that plays when a the puzzle is correctly 

solved

  <!---#LOSESOUND#---> <!---#PN_LOSESOUND#---> Filename of the sound file that plays when the puzzle is not solved 

correctly

<!---#RIGHTSOUND#---> <!---#PN_RIGHTSOUND#---> Filename of the sound file that plays when a correct answer is found

 <!---#WRONGSOUND#--->   <!---#PN_WRONGSOUND#---> Filename of the sound file that plays when a wrong answer is found

<!---#PN_SEPCHAR#---> User Defined Separator character

<!---#PN_SEPARATORS#---> Flag indicating the Word Separator Characters preferences

<!---#FIRSTFOOTER#--->    First Footer

<!---#SECONDFOOTER#---> Second Footer

<!---#TOPHORIZONTALLINE#--->   Location of Top Horizontal Line
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<!---#BOTTOMHORIZONTALLINE#---> Location of Bottom Horizontal line

<!---#PUZZLEFILE#--->      Puzzle file for printable puzzles
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End User License Agreement (EULA) for Crossword Construction Kit

Agreement 

The use of this Software indicates your understanding and acceptance of the following terms and conditions. If you 

do not understand or accept these terms you must cease using this product immediately. 

 

Copyright 

This product is Copyright © by Insight Software Solutions, Inc. and is protected by United States copyright law and 

various international treaties. All Rights Reserved. 

 

License 

You may use an unlicensed copy of this Software for up to 30 days for evaluation purposes only. After the 30 day 

evaluation period you must purchase a license to continue to use the Software.

Once you have purchased a license you will receive a license code that will enable you to continue using the 

Software on a non-exclusive basis. This license will not expire.

The Software is licensed, not sold. Ownership of the Software, Documentation and all intellectual property rights 

therein shall remain at all times with Insight Software Solutions, Inc. In licensing the Software you do not acquire 

any rights beyond the right to continue to use the Software on the system for which you purchased the license.

Personal License: A single-user ("Personal") License may either be used by a single user who uses the Software 

personally on one or more computers, or installed on a single computer used by multiple people, but not both.

Multi-User License: A multiple-user ("Multi-User") License may be purchased based upon either (a) the number of 

users who have access to the Software on any number of computers, or (b) based upon the number of computers on 

which the Software will be installed for use by any number of users. You may not use the Software in excess of 

either (a) the number of purchased users or (b) the number of purchased computers, whichever is applicable. A 

Multi-User License may not be used by your subsidiary companies, customers, or any other third parties.

You shall be responsible for maintaining the License in a safe location and are specifically prohibited from 

distributing the License, intentionally or unintentionally, to any third party. Upon loss or distribution of the License, 

Customer shall be required to pay a reinstatement fee at Insight Software Solution's discretion.

License Transfer

You may not sell, rent, lease, or transfer the Software to any third party and may not lend the Software other than as 

authorized by this EULA.

You may transfer the product to another party only if the other party agrees to all the terms and conditions of this 

agreement and if you provide Insight Software Solutions notice of the transfer including your name, company (if 

applicable), and address and the name, company (if applicable), and address of the person to whom you are 

transferring the rights granted herein. If you transfer the program you must at the same time transfer or destroy any 

back-up copies. You may not retain any portion of the program, in any form, under any circumstance. If the Product 

is an upgrade, any transfer must include all prior versions of the Product. You must secure written approval and a 

personalized license code from Insight Software Solutions, Inc. The license code issued to the initial user will be 

invalidated.

If the Software was purchased as part of a Multiple User license, you may only sell or transfer the entire multiple 

user license; you may not sell or transfer a portion of a Multiple User license. You may not sell or transfer any Trial 

Version or Not For Resale Version of the Software. The sale or transfer of the Software does not transfer the 30 day 

money back guarantee offered to the original purchaser.

Restrictions 

You may not copy, modify, translate, loan or create derivative works based upon the Software or any part thereof.  

You may not reverse engineer, decompile, adapt, or disassemble the Software, nor shall you attempt to create the 

source code from the object code of the Software. You may not attempt to unlock or bypass any licensing algorithm 
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source code from the object code of the Software. You may not attempt to unlock or bypass any licensing algorithm 

utilized by the Software. You may not distribute the license code you received when purchasing the Software or 

post this information to discussion forums, web sites, email messages or servers. You may not remove or modify 

any copyright notices. Violations will result in termination of this license. 

  

Limited Warranty 

Insight Software Solutions, Inc. warrants that the Software will perform substantially in accordance with the user 

documentation for a period of ninety (90) days from the date of receipt.  This limited warranty is void if failure of 

the Software has resulted from accident, abuse, or misapplication. Any replacement Software will be warranted for 

the remainder of the original warranty period or thirty (30) days, whichever is longer. 

  

Disclaimer of Warranty 

THERE ARE NO OTHER WARRANTIES RESPECTING THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT 

LIMITATION ANY REPRESENTATIONS OR ENDORSEMENTS REGARDING THE USE OF, THE RESULTS OF, OR 

PERFORMANCE OF THE PRODUCT, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, ACCURACY, RELIABILITY, 

OR THAT THE SOFTWARE IS ERROR FREE. THE ENTIRE RISK AS TO THE USE OF THIS SOFTWARE IS ASSUMED BY THE USER 

AND/OR LICENSEE. INSIGHT SOFTWARE SOLUTIONS, INC. DOES NOT ASSUME LIABILITY FOR THE USE OF THIS 

SOFTWARE BEYOND THE ORIGINAL PURCHASE PRICE OF THE SOFTWARE. IN NO EVENT WILL INSIGHT SOFTWARE 

SOLUTIONS, INC. BE LIABLE FOR ADDITIONAL DIRECT OR INDIRECT DAMAGES INCLUDING ANY LOSS OF PROFITS OR 

OTHER INCIDENTAL, SPECIAL, EXEMPLARY OR CONSEQUENTIAL DAMAGES ARISING FROM ANY DEFECTS, OR THE USE 

OR INABILITY TO USE THE SOFTWARE, EVEN IF INSIGHT SOFTWARE SOLUTIONS, INC. HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED 

WARRANTY LASTS, SO LIMITATIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, 

AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY BY JURISDICTION. 

 

Customer Remedies 

The entire liability of Insight Software Solutions, Inc. and your exclusive remedy shall be, at the option of Insight 

Software Solutions, Inc., either (a) return of the original purchase price paid for the Software, or (b) repair or 

replacement of the Software that does not meet the Limited Warranty and that is returned to Insight Software 

Solutions, Inc. with a copy of your receipt. 

  

Export Controls 

None of the Software, Documentation or underlying information or technology may be downloaded or otherwise 

exported or re-exported (i) into (or to a national or resident of) Cuba, Iraq, Libya, Yugoslavia, North Korea, Iran, Syria 

or any other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S. Treasury Department's list 

of Specially Designated Nationals or the U.S. Commerce Department's Table of Denial Orders. By downloading or 

using the Software, you are agreeing to the foregoing and you are representing and warranting that you are not 

located in, under the control of, or a national or resident of any such country or on any such list. 

  

In addition, if the licensed Software is identified as a not-for-export product (for example, on the box, media or in 

the installation process), then the following applies: EXCEPT FOR EXPORT TO CANADA FOR USE IN CANADA BY 

CANADIAN CITIZENS, THE SOFTWARE AND ANY UNDERLYING TECHNOLOGY MAY NOT BE EXPORTED OUTSIDE THE 

UNITED STATES OR TO ANY FOREIGN ENTITY OR "FOREIGN PERSON" AS DEFINED BY U.S. GOVERNMENT REGULATIONS, 

INCLUDING WITHOUT LIMITATION, ANYONE WHO IS NOT A CITIZEN, NATIONAL OR LAWFUL PERMANENT RESIDENT 

OF THE UNITED STATES.  BY DOWNLOADING OR USING THE SOFTWARE, YOU ARE AGREEING TO THE FOREGOING AND 

YOU ARE WARRANTING THAT YOU ARE NOT A "FOREIGN PERSON" OR UNDER THE CONTROL OF A FOREIGN PERSON. 

  

High Risk Activities 

The Software is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-line control 

equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear 

facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons 

systems, in which the failure of the Software could lead directly to death, personal injury, or severe physical or 

environmental damage ("High Risk Activities").  Insight Software Solutions, Inc. specifically disclaims any express or 

implied warranty of fitness for High Risk Activities. 

  

Terms 

This license is effective until terminated. You may terminate it by destroying the Software, the documentation and 
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This license is effective until terminated. You may terminate it by destroying the Software, the documentation and 

copies thereof.  This license will also terminate if you fail to comply with any terms or conditions of this agreement. 

You agree upon such termination to destroy all copies of the Software and of the documentation, or return them to 

Insight Software Solutions, Inc. 

 

Other Rights 

No amendments or modifications may be made to this Agreement except in writing signed by both parties. 

If one or more provisions of this Agreement are found to be invalid or unenforceable, this Agreement shall not be 

rendered inoperative but the remaining provisions shall continue in full force and effect. 

  

No Insight Software Solutions, Inc. dealer, distributor, or agent is authorized to make any modification or addition 

to this Agreement. 

  

All other rights not specifically granted in this license are reserved by Insight Software Solutions, Inc. 

  

Governing Law 

This agreement shall be governed by the laws of the State of Utah. The application of the United Nations 

Convention of Contracts for the International Sale of Goods is expressly excluded. 
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Upgrade Policy 

When you purchased Crossword Construction Kit, you were supplied a License Key. It is important that you keep this 

key in a secure place as you will need it whenever reinstalling Crossword Construction Kit. 

   

This license key is valid for any version 5.x of Crossword Construction Kit. Future revisions that bear the "5.x" 

identifier version, will generally be for minor enhancements and bug-fixes. Any release containing major new 

functionality will bear a different version identifier (e.g., 6.x) and an upgrade fee will be chargeable. 

  

The prime location for new releases is the Crossword Construction Kit web site - www.crosswordkit.com. 

   

If you do obtain a newer version of the product, install it over top of your existing version (into the same folder). 

   

Note: Uninstalling and then reinstalling Crossword Construction Kit will not affect your puzzle file(s). Your puzzle 

file(s) will remain intact. However, as always, we recommend that you back-up your puzzle (.cw3) file(s) before 

uninstalling or reinstalling. 
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Support 

For questions or comments regarding Crossword Construction Kit please visit our support page. The program Help 

file, Frequently Asked Questions or online Knowledge Base may also contain an answer to your question. 

If you are experiencing an issue with Crossword Construction Kit, please provide the following: 

The product name and version number. (Click on Help | About for version information.)

The version of Windows you are running (XP, Vista, 7, 8.1, etc.) including service packs.

The sequence of actions that produces the problem.

Any other relevant details.

Before contacting us for technical support, please make sure that you are using the latest version of  Crossword 

Construction Kit, as the problem may have been fixed in a later update. Information about the latest release may be 

found at www.crosswordkit.com/download.htm. 
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Frequently Asked Questions 

We obviously can't anticipate all the frequently asked questions that will come our way. So if you do not see an 

answer here, visit our web site at www.crosswordkit.com and look at the FAQs there for a possible solution. 

General Questions  

With so many options and features, is the program as complicated to use as it may appear? 
Actually the program is very easy to use. There are only a few simple steps to follow to create a great looking 

puzzle. Just enter the title, words and clues, select a puzzle shape and page layout and press a button to generate 

the puzzle. Choose from the four best puzzle fits, save it and print. 

  

Of course you can spend more time if you want to design your own puzzle shapes and page layouts, use the spell 

checker and thesaurus and other options. But the bottom line is that you can realistically create a puzzle in a matter 

of minutes, provided you are not stumped trying to think up clues for your words. We've added the thesaurus to 

help you in that regard. If you feel you need more help, a good place to start would be the Tutorial. 

  

I copied an HTML created web page to my web site and everything appeared except for the puzzle itself. 

Why? 
Both an HTML file (htm) and JPEG file (jpg) will be saved out with the name you selected. Both of these files must 

be placed on your web site for the page to appear correctly. 

Page Layouts

I sent a puzzle page layout I created to a friend who also uses the Crossword Construction Kit. When the 

layout was opened, the image was missing. Why? 
Images are not embedded into the puzzle layouts. If you export a page layout and the layout contains a bitmap or 

other type image, the recipient of the page layout will also need access to the image. The layout looks for the 

location on your computer where the image is stored. In essence you need to send both the layout and the image 

file. They would then have to link the image to the layout. 

  

How can I create a two page layout? 
You would need to create two separate page layouts. For example you can place the puzzle and title on one of the 

page layouts. Then create another layout that would contain the down/across clues and headers along with any 

other text components you may want to place on the page. After you have designed the two layouts, print each one 

separately. The puzzle will print on page one and the clues on the following page. 

  

I would like to transparently place a puzzle over the top of a graphic image. How do I do this? 
When creating your page layout, you would need to change the puzzle to a skeleton puzzle. A skeleton puzzle only 

includes the boxes that contain letters. None of the filler boxes used to create the shape appear with the skeleton 

puzzle. Here's the process for making a skeleton puzzle. In the Page Creator Window, place the puzzle component 

onto the layout. Right click on the puzzle component box you dropped in the layout to open a context menu. Click 

on Properties and select the Skeleton Puzzle option. 

  

While creating a page layout I was using the Size and Position option to position an object on the page. 

I accidentally typed in a value that positioned the object off of the page and now can't right click on it 

to reposition. What should I do? 
As an example let's say that you positioned the Title off of the page layout. Since it's off the page, you cannot right 

click on the object to bring up the menu options. The Title button has been grayed out so you can't just place 

another title object on the page. But you do have the option to click on the Objects button and select Title from the 

list of objects that you've already added to the page layout. The menu options for Title will appear where you can 

select Size and Position to correctly reposition the Title. 

      

How can I enlarge the squares of the puzzle? 
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How can I enlarge the squares of the puzzle? 
The answer to this depends on a couple of factors. These include the puzzle shape chosen and the size of the Puzzle 

Object on the page layout you are using. The puzzle shape expands to fill the area designated for the puzzle on the 

page layout. Let's examine how the puzzle shape first impacts the squares on the puzzle. 

  

When you create a puzzle, you have the option to select a Puzzle Shape by clicking on the Shapes button. You can 

choose squares, triangles, circles, cars and a variety of other shapes for the puzzle. Let's compare a puzzle shape of a 

10 x 10 square to that of a 20 x 20 square. In each case, the puzzle will fill the exact same area on the printed page. 

However, the 10 x 10 puzzle will have bigger squares because there are squares for the same amount of space. So, 

the larger the dimensions of the puzzle shape, the smaller the puzzle squares will be. 

  

The second factor is decided by the page layout selected. The larger the area for the puzzle in the page layout, the 

larger the puzzle squares will be. The program comes with a few predefined page layouts, but you can also create 

any number of additional layouts. You can determine where to place the puzzle and its size.

The Creating a Page Layout tutorial in the help file walks through the process of designing a layout. A video on our 

website also demonstrates how to do this.

  

How can I print out a list of puzzle words on the same page as the puzzle? 
Create (or modify) a new page layout and add the Word List crossword object to the page layout. You can create, 

modify or copy a page layout by choosing Edit | Page Layout from the menu of the Crossword Construction Kit 

window. 

  

How can I make my fonts bigger for the clues, word lists or any part of the printout? 
The following instructions, for the most part, can apply to any of the puzzle objects. There are 3 or 4 factors involved 

in this process. Each requires the modification or creation of a new Page Layout. So let's use the Word List as our 

example. 

  

The factors for the Word List will be the physical size of the object on the Page Layout, the actual font size chosen, 

the Make It Fit (Auto Shrink Font) option and number of columns used. While in the Page Layout Designer, each of 

these factors can be modified by right clicking on the Word List object and selecting the appropriate menu item. 

• The size of the object can be changed using the Size & Position menu option. 

• The font size can be changed using the Text Font menu option.

• The Make It Fit and the Number of Columns can be changed using the Properties menu option. 

We'll examine how these factors all interact. The most obvious is the Size factor. The larger the area you provide for 

the word list, the larger potential font size you can use. 

  

However, the other factors also make a definite impact. So let's next look at the Font Size itself. Here you can 

specify the size, color, style, etc of the font to be used. So you choose a font size of 20. But how do you know if that 

font is too big or small to be used in the designated area? This is where the Make It Fit option comes into play which 

is a default value. 

  

The Make It Fit option will ensure that your text will fit in the area you have designated. It does so by first using the 

font you have selected and continually shrinking its size until it fits in the area specified. If you do not use this 

option, then the font size selected will be inserted. However, you run the risk of the font being too large and if it is, 

some of the words will not appear because they do not fit in the designated area. We recommend that you use the 

"Make It Fit" option in most instances. 

  

The last factor here is the number of columns. The default is set to a single column. So if the area (size) where you 

are placing the word list is not a long vertical strip, but a horizontal area, you will want to increase the number of 

columns. 

  

In summary, for the best results, you will want to do the following:

1. Choose an adequate size to hold all the words.

2. Choose an adequate number of columns to use based on the size.
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3. Choose a very large font size. 

4. Choose the Make It Fit (Auto-Shrink Font) option. 

How can I make my changes such as font size, colors, etc. permanent? 
Font sizes, colors, etc. are all tied directly to the Page Layout and the values are saved permanently with the Page 

Layout. So to make permanent changes, you need to modify or create a Page Layout. To associate your newly 

created or modified page layout with an existing puzzle, double click on the puzzle of choice from the Crossword 

Construction Kit window. On the resulting screen, click on the Layout button. Next highlight your puzzle layout you 

just created or modified and click on the Select button. And finally click on the Save button. 

  

If you modified a Page Layout that is associated with an existing puzzle, you still need to associate the new 

modified Page Layout with the puzzle. The puzzle maintains the old information until the change has been saved. 

The Print window provides an area where you can Override the Page Layout, Fonts, etc. These Puzzle Overrides are 

temporary and only affect the puzzle for the current print job. 

 

 

Exporting Graphics

We seem to receive a good number of questions regarding the exporting of graphic files. We will attempt to answer 

many of them here, ranging from basic to more technical. First, the program currently allows 5 different types of 

graphic files to be exported. These include Windows Meta Files (WMF), Enhanced Windows Meta Files (EMF), 

Bitmap (BMP), JPEG (JPG) and PING (PNG). So let's answer some questions about these. 

  

How do these graphic files differ and are there any limitations or advantages? 
Both the meta file formats are saved in a scalable format. This means that the puzzle images, text, etc. will normally 

expand and shrink within your graphics program and retain their correct proportions. Bitmaps, PNG and JPEG images 

are exact images. If you attempt to shrink these in a graphics program you are going to lose part of the image. If 

planning to use bitmap, JPEG or PNG files for use with other programs, it is best to first set the size of the image in 

the Crossword Construction Kit so that you will have a clean looking image.   

  

My Bitmaps are not legible once I import them into my word processor or into my graphics package. 

What can I do? 
There could be two potential problems here. The first is that you could have saved out the bitmap in a very small 

size. If this is the case, then the puzzle and clues, etc. will likely not be very legible. Attempts to enlarge the image 

in your word processor or graphics package will fail because bitmaps do not scale well. The second problem could 

be that you have saved the bitmap out in too large of a size. Here the detail might be fine, but because you are 

attempting to shrink the bitmap in your word processor or graphics program, you lose part of the image and once 

again the resulting image is not legible. 

  

The key to resolving these problems is to have Crossword Construction Kit create the bitmap in the correct size that 

you need. Then import the bitmap into your program and leave it at its original size. 

  

So how do you set the size? The program will prompt for the number of pixels to use in the width of the bitmap (the 

height is automatically calculated based on the width). You can also set the pixel width in the preview mode so you 

can see exactly what your resulting image will look like. 

  

I cannot seem to import the Windows Meta File created by the Crossword Construction Kit. Why not? 
Unfortunately it is not likely that you will be able to get it to work. Many standards for the meta file format have 

cropped up since the release of Windows which has created an incompatibility between many programs and files. 

The format we currently use is one that is built into the Borland Delphi/C++ programming language which we feel to 

be quite reliable. We have tested this format with programs such as Paint Shop Pro, Microsoft Word, Microsoft 

Publisher and others which do not seem to have any problems reading the files. 

  

How do I scale a meta file inside my graphics program? 
Some graphics programs will not scale a meta file after it has been loaded. Instead, it will be treated as a bitmap 

with a loss of image if it is shrunk. If you desire to use the scalable features available with a meta file with these 

programs, you will need to locate the option in them to do so. This option is usually used at the time of image 

112



programs, you will need to locate the option in them to do so. This option is usually used at the time of image 

loading. 

  

Can I export just the puzzle portion? 
The only option we currently support is the export of the entire page. So to export just the puzzle, you would need 

to create a page layout that consisted of just the puzzle object and size it so that it covers the entire page. Using this 

page layout, you could then export just the puzzle. 
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Portable Version

A portable version of Crossword Construction Kit is available for use on a USB drive or similar portable device. Install 

Crossword Construction Kit  Portable on the device and run it from that device rather than the local computer. This 

version will not leave traces of the program on the hard drive of the machine where the program is run.

Crossword Construction Kit Portable includes the following differences from the standard version.

• No 30-day trial available.

• The options to import or export the program preferences have been removed.

• There is no uninstaller. Use Windows Explorer to delete the files. 

• The .cw3 file association is not linked to Crossword Construction Kit  Portable. You cannot double-click on a 

.cw3 file to load it into the program.

• Default locations for the .cw3 puzzle file, layouts, temp directory, etc. are stored on the portable drive.

To Run Crossword Construction Kit Portable

When a portable drive is connected to the computer, the AutoPlay menu will typically appear. Click on ‘Open folder 

to view files’ in the AutoPlay menu. Double click on LaunchApps to display a menu similar to the one shown below. 

The menu displays the programs you have installed that are recognized by LaunchApps. Click on the program that 

you want to load. 

 

Or open Windows Explorer to the portable drive and double click on LaunchApps to open the menu.

AutoRun for Windows XP and prior

On Windows XP and prior, you may be able to specify a program to automatically run when the portable drive is 

inserted into your computer. The file autorun.inf allows this to happen (if it is supported by your version of 

Windows). Autorun.inf will only load one program at a time and may be disabled if the AutoRun feature in Windows 

is disabled.

When Crossword Construction Kit Portable is installed it will create an autorun.inf file in the root directory of your 

portable drive if one does not already exist. If your portable drive already contains an autorun.inf when you install 

you may choose to edit it. The autorun.inf file will load the program LaunchApps. LaunchApps may be configured to 

automatically load more than one program. 

The file autorun_ISS.inf demonstrates how autorun.inf could be set to load LaunchApps.
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To close Crossword Construction Kit Portable
Before instructing Windows to eject the portable drive, close Crossword Construction Kit Portable.
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